
Overview

PageGate is a sophisticated wireless messaging (paging) application.    The heart of the application is a high 
throughput paging engine that has the ability to support multiple dialers (modems) or a direct cable connection to a 
paging terminal.    PageGate supports several front-end interfaces (gateways) that can be used alone or in 
conjunction with each other. This allows PageGate to receive messages from many sources, and deliver the 
messages to wireless messaging devices (including alphanumeric pagers, numeric pagers, mobile phones, PIMs, 
etc.)      The front-end interfaces include: NotePager Net, a GUI windows client which enables an entire network to 
send messages from windows workstations, a Commandline/Ascii interface which enables many 'off the shelf' and 
custom applications to send messages to PageGate, an Email gateway interface which allows email messages to be 
sent to PageGate, a CGI web server interface which allows messages to be sent directly from web pages, and a 
TTY/TDD interface which enables PageGate to receive messages from TTY/TDD devices.    PageGate's modularity 
(PageGate's modules can be run across several separate machines), scalability (direct cable connection and support 
for multiple dialers), multiple front-end interfaces, and high-end features (group paging, scheduled pages, repeating 
pages, on-call groups, and ad-hoc paging) makes it a perfect fit for most wireless messaging needs.



Shareware Information

PageGate defaults into a 'shareware mode' until it is registered (purchased).    Registration information can be 
entered into PageGate's Admin program by choosing the 'Register' menuitem from the 'Help' menu.    The shareware 
version of PageGate only allows for the setup of two users, and will stop itself every 3-5 days.    PageGate's admin 
program must be used to restart the paging engine after this time period.



Contact Information

NotePage, Inc.
291 Rockland Street
Suite 13
Hanover, MA    02339
USA

web www.notepager.net

email sales@notepager.net

phone (781) 829-0500
fax (781) 826-3432
tty (781) 829-5067 



Version Information

PageGate Help File - NotePager Net Version

Help file version 1.2

for PageGate version 2.0

Copyright 1997-1999 NotePage, Inc.



System Requirements

PageGate can be used on Windows95, Windows98, Windows NT workstation, or Windows NT server computers.

PageGate (server) minimum requirements:
Pentium processor
Windows95/98:

24 Meg RAM minimum (32 recommended)
Windows NT server/workstation

48 Meg RAM minimum (64 recommended)
50 Meg free hard disk space (more for larger databases)
300 baud modem minimum or a direct cable connection to a paging terminal



Information you will need to run PageGate

1. The com (communications port) of your modem.    A 300 baud or greater modem is required by PageGate.    
PageGate must have exclusive use of the modem (i.e. no other communications programs can use the 
modem at the same time even if they are running in the background and not currently using the modem)

2. A pager (alphanumeric pager, numeric* pager, mobile phone, PIM, etc.).    Alphanumeric pagers can better use the 
full capabilities of PageGate, however numeric pagers are also supported.    *Some paging carriers do not 
allow sending messages to numeric pagers via modem.    Check with your paging service provider for this 
capability. 

3. The phone number of your paging service provider's terminal.    This is not the same number you dial to send a 
message via a touch tone phone, or the number to send an operator assisted message.    This is the 
TAP/IXO paging terminal modem phone number for your paging carrier.

4. The communications setting needed to connect to your paging carrier's modem.    You must get the baud rate, 
parity, data bits, and stop bit settings to be used with your carrier.

5. The ID or PIN number for your pager.    When PageGate talks to your paging carrier, it must give an ID or PIN 
number to uniquely identify your pager.    ID numbers are usually seven digits long.    the ID may be the 
phone number of your pager, or a totally different number altogether.    You must obtain this number from 
your paging carrier to be able to send messages to you pager.



First Time Setup

The first time you start PageGate you will be prompted for a 'Data Directory'.    This is where PageGate's main 
database file will be kept.    This file must be accessible (through the network) by all the NotePager Net workstations.   
It an be kept on the same machine as the PageGate program files (the default), or in any other shared directory on 
the network.    Network traffic generated by PageGate can be kept to a minimum by specifying a local directory for the
PageGate database file.    The default is PageGate's program directory.    Next, PageGate's Admin program's window 
will be displayed.    The scheduler (SCHED) and engine (ENGINE) modules will also appear.    

There are some initial settings to be made before pages can be sent.

1. Setup the modem port
a. Go to 'Tools' -> 'Setup' -> 'Engine' (tab)
b. Set the 'Engine Port' to the com port your modem is connected to.    If you are using a direct cable connection, 

check the 'Engine is direct connect' box
c. Apply your changes

2. Add a carrier
a. Go to 'Carriers' -> 'Add'
b. In the 'Carrier' field, enter a name for your paging carrier (service provider)
c. In the 'Phone Number' field, enter the phone number for your carrier's paging terminal. Be sure to include any 

prefixes needed to obtain an outside line, or any long distance prefixes
d. Enter the 'Baud Rate', 'Parity', 'Data Bits', and 'Stop Bits' your carrier's terminal uses (the most common 

settings are 1200,e,7,1)
e. Enter an 'Init String' for your modem to aid it in communicating with your carrier.    Different init strings may be 

needed for each carrier you setup.    In addition, init strings can be different for different modems you use.    
Some modem/carrier combinations may not require an init string at all.    In general, if your modem dials out, 
the carrier picks up the call (high pitched tone), but messages aren't sent, you may require an init string.    
Here are some common init strings: (see the troubleshooting section for more information on init string)

AT&FQ0V1X4&D2 - Minimal settings.    Works with most 1200 and 2400 baud modems. Some modems use &F0 
rather than &F.    All '0' are zeros not ohs.

AT&FQ0V1X4&D2N0S37=5 - Hard coded baud rate.    Works with many 14.4 and 28.8 modems.    The added 
codes locks the connection baud rate to 1200 baud.    Use S37=3 for a 300 baud connection, and S37=6 for 
a 2400 baud connection.    Some modems use &F0 rather than &F.    All '0' are zeros not ohs. 

AT&FQ0V1X4&D2N0SE7=5\N0%C0 - No compression/error correction.    Works with many 14.4, 28.8 and 33.6 
modems.    The added codes turn off data compression and error correction.    You can try using only one of 
the two additional codes (\N0 or %C0) if you modem rejects using both.    Use S37=3 for a 300 baud 
connection, and S37=6 for a 2400 baud connection.    Some modems use &F0 rather than &F.    All '0' are 
zeros not ohs.

AT&F0Q0V1X4&D2&B1&K0&M0&N2 - USRobotics (3Com) string.    Works with most USRobotics/3Com 33.6 
and 56K modems (and some others too).    Use &N1 (instead of &N2) for a 300 baud connection, or &N3 for 
a 2400 baud connection.

Please see the 'Reference' section for more information about modems

f. Enter the maximum characters your carrier will send in a single message.    Messages longer than this value 
will be automatically spit up into smaller messages by PageGate.    If this is the case, messages segments 
will be labeled 1of_, 2of_, 3of_, etc)

g. If your paging carrier requires a password to connect to them (not very common), enter it into the 'Password' 
field.

h. If your phone line does not have touch tone service on it, check the 'Pulse Dial' option.
i. If you are using a direct cable connection to this carrier, check the 'Direct Connect' option.
j. Apply your changes

3. Add a user (pager)
a. Go to 'Users' -> 'Add'
b. In the 'User' field, enter a short username for the pager
c. Enter the pager's owner's full name in the 'Full Name' field (this is the name that is displayed within the 



NotePager Net client software)
d. In the 'ID' field, enter the pager's ID (Pin number)
e. Choose the carrier for this pager
f. Set the maximum number of characters you want to allow to be sent to this user (pager) in the 'Maxchars' field
g. For numeric pagers (displays numbers only), choose a notification code to be sent to alert the user of the 

arrival of a text message.    Short numeric messages sent using NotePager Net will be sent unchanged.
h. Check the 'Alpha' box if the pager is an alphanumeric model (displays letters and number)
i. Check 'Notify Only' if you want only to send the 'Notification Code' when a message is sent.
j. Check 'Reliapage' if you want each user's (pager's) messages to be numbered sequentially to enable the 

recipient to be able to tell when a message has been missed.
k. Apply your changes.

4. Start PageGate processing 
a. After a carrier and a user are setup, you will be able to start PageGate's Engine and Scheduler modules.    

Click on the 'Start' button under 'Engine' and under 'Sched'.    After a few seconds, the status window under 
each of the above should change from 'Stopped' to 'Running'    The Engine and Sched modules should also 
change from 'Stopped' to 'Running'



Sending a test message

Go to 'Tools' -> 'Send Message'

Choose a user from the list of users

The 'Send Message' window will appear

Enter whom the message is from

Enter a short message

Click the 'Send' button

Soon, the Scheduler should increment it's 'Good' message counter

Shortly after that, you should see the Engine begin to dial and send the message

If the message is not sent, refer to the 'Troubleshooting' section.



Overview

PageGate's Admin program is used to maintain PageGate.    New objects are entered, settings are changed, and 
modules are started and stopped using Admin.    The Admin screen shows the status of the currently enabled 
modules.    Directly below the module's headings, a status windows shows whether the module is currently running or 
stopped.    The button below the status windows is used to either start or stop the module.    Keep in mind that the 
Admin screen updates according to the polling interval set on the Admin setup screen.    After clicking on a module's 
start/stop button, wait for the Admin screen to update before clicking it again.    Only one copy of Admin should be run 
at a time.    If more than one instance of Admin is started, you will receive a warning that another copy of the program 
is running.    If you are sure no other copies are running, you may choose 'Clear' to continue to start the Admin 
program.    The Admin program does not need to be running in order for PageGate to operate, but it must be used to 
make any changes in the application.    The Admin program can be run on the machine running the rest of 
PageGate's modules, or can optionally be run on any workstation that is networked to the PageGate server computer.



Starting

PageGate's Admin program is automatically started if the pagegate.exe or the pgstart.exe programs are used to start 
PageGate.    The pagegate.exe is the default startup program in the windows start menu.    Admin can be manually 
started by running the pgadmin.exe program.



Running on a separate computer

PageGate's Admin program can be installed and run on a separate machine than the PageGate paging server 
application.    To do this, install PageGate on the remote system following the regular installation instructions.    After 
the installation is finished modify the icon in the windows start menu to run pgadmin.exe rather than pagegate.exe.    
When the Admin program is run for the first time, it will prompt you for a path to the PageGate database.    Enter the 
path (or browse using the ... button) to the existing PageGate database on the PageGate server computer.



Overview

PageGate's scheduler program is responsible for queuing all messages to be sent out by PageGate's dialers.    
Groups, on-call groups, future scheduled messages, and repeating messages are also the responsibility of the 
scheduler.    The status field on the scheduler's window shows whether the scheduler is 'Running', 'Stopped', or 
executing the 'Cleanup Routine'.    The 'Last Message From' field shows who the last processed message was sent 
from.    The 'Last Message To' field show who the last processed message was sent to.    The 'Good' and 'Bad' fields 
show how many messages were successfully and unsuccessfully processed by the scheduler.



Starting

PageGate's scheduler module is automatically started if the Pagegate.exe, pgstart.exe, or pgstartm.exe programs are
used to start PageGate.    The pagegate.exe is the default startup program in the windows start menu.    The 
scheduler can be manually started by running the pgsched.exe program.



Running on a separate computer

PageGate's scheduler module can be installed and run on a separate machine than the rest of the PageGate paging 
server application.    To do this, install PageGate on the remote system following the regular installation instructions.    
After the installation is finished, manually run the pgadmin.exe program from the PageGate program directory.    
When the Admin program is run for the first time, it will prompt you for a path to the PageGate database.    Enter the 
path (or browse using the ... button) to the existing PageGate database on the PageGate server computer.    Quit out 
of the PageGate programs. The scheduler module (pgsched.exe) can now be run on this machine.    You may want to
create an icon to make it easier to start.



Overview

The 'Engine' module is PageGate's primary dialer module.    It will dial out whenever messages are pending in the 
message queue.    The additional dialers (Dialer1 - Dialer4) only start when needed (additional dialers are purchased 
separately).    The 'Engine' module is the only dialer that can be connected directly to a paging terminal with a direct 
serial cable.    All of PageGate's dialers use intelligent messages queuing logic.    For example, if you own more than 
one dialer module, and more than one carrier has messages pending, more than one dialer will start.    Once a 
connection is made to a carrier, all the messages for that carrier will be sent before hanging up.    If there are many 
messages for the same carrier, one or more additional dialers will startup to help send the messages.    The status 
field on the engine's window shows whether it is 'Running' or 'Stopped'.    The carrier field shows what carrier is 
currently being connected to.    The user field shows what user the current message is being sent to.    The modem 
field shows the modem's current activity.    The good and bad fields show how many messages were successfully or 
unsuccessfully sent by the engine.



Starting

PageGate's engine is automatically started if the pagegate.exe, pgstart.exe, or pgstartm.exe programs are used to 
start PageGate.    The pagegate.exe is the default startup program in the windows start menu.    The engine can be 
manually started by running the pgengine.exe program.



Running on a separate computer

PageGate's engine can be installed and run on a separate machine than the rest of the PageGate paging server 
application.    To do this, install PageGate on the remote system following the regular installation instructions.    After 
the installation is finished, manually run the pgadmin.exe program from the PageGate program directory.    When the 
Admin program is run for the first time, it will prompt you for a path to the PageGate database.    Enter the path (or 
browse using the ... button) to the existing PageGate database on the PageGate server computer.    Quit out of the 
PageGate programs. The engine (pgengine.exe) can now be run on this machine.    You may want to create an icon 
to make it easier to start.



Overview

Dialer2-Dialer4 are PageGate's additional dialer modules.    The additional dialers (Dialer2 - Dialer4) only start when 
needed (additional dialers are purchased separately).    An additional dialer is started whenever there are more 
carriers to be contacted (in queued messages) than there are dialers currently connecting to carriers.    You can also 
set the additional dialers to startup if there are a set number of messages waiting in the message queue.    The status 
field on the dialers shows whether they are 'Running' or 'Stopped'.    The carrier fields show what carrier is currently 
being connected to.    The user fields show what user the current message is being sent to.    The modem fields show 
the modem's current activity.    The good and bad fields show how many messages were successfully or 
unsuccessfully sent by each dialer.



Starting

PageGate's dialers are automatically started if the pagegate.exe, pgstart.exe, or pgstartm.exe programs are used to 
start PageGate.    The pagegate.exe is the default startup program in the windows start menu.    The dialers can be 
manually started by running the dialer2.exe, dialer3.exe, or dialer4.exe programs.



Running on a separate computer

PageGate's dialers can each be installed and run on a separate machines than the rest of the PageGate paging 
server application.    To do this, install PageGate on the remote system following the regular installation instructions.    
After the installation is finished, manually run the pgadmin.exe program from the PageGate program directory.    
When the Admin program is run for the first time, it will prompt you for a path to the PageGate database.    Enter the 
path (or browse using the ... button) to the existing PageGate database on the PageGate server computer.    Quit out 
of the PageGate programs. The dialer (dialer2.exe, dialer3.exe, or dialer4.exe) can now be run on this machine.    You
may want to create icons to make it easier to start them.



Data Directory

The first time PageGate is run, you will be prompted for a path to where you want the PageGate database to reside 
(pagegate.mdb).    The default path is to the PageGate program directory where PageGate is installed.    If the 
NotePager Net (GUI) front-end is to be used, the PageGate database must be accessible by the NotePager Net 
(GUI) clients.    Therefore, it would need to be in a shared network folder.    Network traffic can be kept to a minimum if
the database is stored on the same machine that PageGate runs on.    To move the database file any time after the 
initial installation, you must manually move the database to a new location.    You must then manually edit the 
pagegate.ini file found in the PageGate program directory to point to the new location (don't forget the trailing back-
slash).



Engine

PageGate's first dialer (Dialer1) is also known as the PageGate 'Engine'.    It is the only dialer that can accept a direct 
cable connection to a paging terminal (no modem).    It is the primary dialer and should be running at all times.    The 
additional dialers are only activated when necessary (see 'Dialer2', 'Dialer3', 'Dialer4', or 'Dial Threshold').    The 
Engine's display shows the current state of the dialer, what carrier is currently being dialed, what user the current 
message is to, and the current state of the modem.    There are also a 'Good' and a 'Bad' message counter on the 
display.    The Engine's executable file is pgengine.exe, and its detailed log file is 'Dialer1'.



Dialers

Up to four dialers can be used with PageGate (one comes with PageGate).    Each dialer requires it's own modem.    
The use of multiple dialers can dramatically increase the throughput of PageGate.    The dialers are intelligent and 
only start when they are need.    An additional dialer will always be started if there are messages to more carriers than
there are dialers currently active.    For example if two dialers are already sending messages, and a new message 
arrives for a third carrier, a third dialer will be started.    A 'Dial Threshold' can also be set (see 'Dial Threshold').    This 
setting specifies the number of queued messages needed before an additional dialer is started.    For example if the 
'Dial Threshold' is set to 10, if 11 messages are queued up, a second dialer will start.    A third dialer would start if 
there were 21 messages queued, and a the fourth dialer would start if there were 31 messages queued.    Each 
dialer's display shows the current state of the dialer, what carrier is currently being dialed, what user the current 
message is to, and the current state of the modem.    There are also a 'Good' and a 'Bad' message counter on each 
display.    PageGate comes with one dialer by default (Engine).    Additional dialers can be purchased separately.



Scheduler

PageGate's scheduler module is responsible for queuing up all messages.    On-call groups, future scheduled pages, 
and repeating pages are also handled by the scheduler. In addition, the scheduler runs a 'Cleanup Routine' whenever
it is started, and at the end of every day.    This routine trims the log files and purges the database of old messages 
(see 'Log Length' and 'Purge After').    The scheduler's display shows the status of the scheduler, what carrier the last 
message was for, and what user the last message was to.    There is also a 'Good' and a 'Bad' message counter 
displayed.    The scheduler should be running a all times.    The scheduler's executable file is pgsched.exe.



GetAscii

PageGate's Commandline/Ascii front-end interface.    When running, it allows messages to be sent to PageGate from 
an DOS/Windows commandline or by putting an Ascii text file with message date in a predefined directory.



GetMail

PageGate's Email front-end interface.    When running, it retrieves email messages from the MDaemon Mail server.



GetWeb

PageGate's web server front-end interface.    When running is accepts messages from web servers by using the 
included webgate CGI program.



GetTTY

PageGate's TTY (TDD) front-end interface.    When running it accepts phone calls and messages from TTY (TDD) 
devices. 



Running

On PageGate's Admin program's display, the status of each of PageGate's modules is shown.    When the display 
says 'Running', the associated module is ready to process messages.    A 'Stopped' state indicates that the module 
will not process messages.    These status windows are updated as per the 'Polling Interval' specified on the setup 
screen.    Therefore, there may be a delay in their update if a long 'Polling Interval' is used.



Stopped

On PageGate's Admin program's display, the status of each of PageGate's modules is shown.    When the display 
says 'Running', the associated module is ready to process messages.    A 'Stopped' state indicates that the module 
will not process messages.    These status windows are updated as per the 'Polling Interval' specified on the setup 
screen.    Therefore, there may be a delay in their update if a long 'Polling Interval' is used.



Start

On PageGate's Admin program's display, there are buttons associated with each of PageGate's modules.    These 
buttons allows an administrator to stop or start any one of PageGate's modules individually.    These buttons simply 
start or stop the modules from processing new messages, it does not actually start or stop the modules from running. 
The status windows directly above the buttons are updated as per the 'Polling Interval' specified on the setup screen. 
Therefore, there may be a delay in their update if a long 'Polling Interval' is used.



Stop

On PageGate's Admin program's display, there are buttons associated with each of PageGate's modules.    These 
buttons allows an administrator to stop or start any one of PageGate's modules individually.    These buttons simply 
start or stop the modules from processing new messages, it does not actually start or stop the modules from running. 
The status windows directly above the buttons are updated as per the 'Polling Interval' specified on the setup screen. 
Therefore, there may be a delay in their update if a long 'Polling Interval' is used.



Quitting

PageGate's admin program can be quit by choosing 'Exit' from the 'File' menu.    Clicking on the 'X' in the upper right 
corner, or double-clicking on the icon in the upper left corner will also close the Admin program.    The other modules 
can be closed by choosing the 'Quit' button, clicking on the 'X' in the upper right corner, or by double-clicking on the 
icon in the upper left corner.



Starting PageGate

There are several ways to start PageGate.    The default method is to choose the icon installed in the start menu.    
This runs a program called pagegate.exe.    Pagegate.exe will start all the modules including the Admin program.    If 
you have a registered version, there are two alternate startup programs available.    Pgstart.exe will start all the 
modules including the Admin program, but all the modules will be started in a 'Running' state.    Pgstartm.exe will start
all the modules (not Admin) in a minimized and 'Running' state.    Each of PageGate's modules can also be started 
individually by simply running their executables manually.



Setup

PageGate's 'Setup' screen can be started by choosing 'Setup' from under the 'Tools' menu.    There are several tabs 
to choose from on the setup screen.    Only the 'Admin', 'Engine', and 'Sched' tabs are used with NotePager Net.    
The 'Admin' tab contains general PageGate settings and settings relevant to the PageGate Admin program.    The 
'Engine' tab contains settings relevant to PageGate's dialers.    The 'Sched' tab contains settings for the scheduler 
module.

Admin Tab
Log to Disk

Enables/Disables PageGate's general log.    The general log contains rejected, successful, and failed 
message information.

Detailed Log
Enables/Disables PageGate's detailed logs.    Each dialer has it's own detailed log.    It contains detailed 
information about the dialer's conversations with the paging carrier's terminals.

Polling Interval
This sets how often (in seconds) the Admin program updates its main status screen.

Log Length
This sets how many lines will be kept in the log files.    The logs are trimmed each night.

Purge After
This sets how long sent messages are kept in the PageGate database before they are deleted.

Engine Tab
Polling Interval

This sets how often the dialers check for new messages.    A short interval is less likely to queue up 
messages to be delivered during one connection.    A long interval will queue more messages for delivery but
may can delay the time it takes for a user to receive a message.

Dial Threshold
This sets how many messages must be in the queue before an additional dialer is started to aid in delivering
the messages.    This setting only has relevance if you own more than one dialer.

Retries
This sets how many times a carrier is redialed before all the messages pending for that carrier are marked 
as bad.    A value of zero means infinite number of retries.

Retry Interval
This sets (in seconds) how long to wait between retries when unable to connect to a carrier.

Engine Port
This sets the com port for the modem to be used by the Engine (Dialer1).

Dialer2 Port
This sets the com port for the modem to be used by the second dialer.

Dialer3 Port
This sets the com port for the modem to be used by the third dialer.

Dialer4 Port
This sets the com port for the modem to be used by the fourth dialer.

Engine is Direct Connect
This sets the Engine (Dialer1) to direct connect mode.    Meaning, the Engine (Dialer1) has a direct cable 
connection the a paging terminal and doesn't use a modem.

Sched Tab
Polling Interval



This sets how often the scheduler checks for new messages.    Too small a value may generate unnecessary
processor usage, while too large a value may delay the delivery of messages.    A setting of 5 is the default.

GetAscii Tab
Polling Directory

Enter (or browse using the … button) a path to the directory where you want GetAscii to check for message 
files.    Ascii text file can be put here that contain message data, or you can instruct sendpage.exe to use this
directory to create its files.

Enabled
Check this box to enable the GetAscii front-end interface.

Polling Interval
How often (in seconds) GetAscii checks for the arrival of new messages in the Polling Directory

GetMail Tab
Mail Server Path (local)

This is the path to the MDaemon mail server by the point of view of the mail server itself.    It must be a local 
path starting with a drive letter (i.e. c:\mdaemon).    The mail server uses this setting when creating new mail 
accounts.

Mail Server Path (network)
This is the path to the MDaemon mail server by point of view of a networked workstation.    It should be an 
UNC path starting with a server name (i.e. \\ntserver\c-drive\mdaemon).    PageGate's GetMail and Admin 
modules use this setting to retrieve messages from and control the mail server.    If all of PageGate's 
modules and the mail server are running on the same machine, a local pathname can be used.

Enabled
Check this box to enable the GetMail front-end interface.

Polling Interval
How often (in seconds) GetMail checks the mail server for the arrival of new messages.

Default Domain Name
This is the default domain name that is appended to messages received by PageGate that do not already 
contain a domain name.    Some mail systems will not accept messages without a valid sender's domain 
name.

GetWeb Tab
Web Pages Path

This is the path to the directory where all the user web page directories will be created under.    The 
templates and images directories are also created beneath this directory.    In many cases this would be the 
root directory of the web server.    PageGate must have full rights to this directory in order to create web 
pages for PageGate users.

CGI Data Path
This is the path to the directory where the web CGI (webgate.exe) will create its temporary files.    Typically 
this is the same directory that the webgate CGI resides in.    Most commonly a directory called cgi-bin or 
scripts is used.

Enabled
Check this box to enable the GetWeb front-end interface.

Polling Interval
How often (in seconds) GetWeb checks the mail server for the arrival of new messages.

GetTTY Tab
Modem Port

The COM port (serial port) where the TTY/Modem is installed.
Enabled

Check this box to enable the GetTTY front-end interface.

Polling Interval
How often (in seconds) GetTTY updates it's statistics.





Send Message

A message can be sent from directly within PageGate's Admin program.    This can be useful for testing purposes.    
Choose 'Send Message' from under the 'Tools' menu to access this option.    You are first prompted with a list of user 
to send the message to.    Choose a user by double-clicking on the name, or by highlighting the user and hitting the 
'Send' button.    The 'Send Message' screen will now be displayed.    Enter who the message is from (You), and enter 
a short message in the 'Message' area.    Press the 'Send' button to send the message.



Requeue Messages

Messages that have already been sent can be resent by using the 'Requeue Messages' feature.    This is especially 
useful when used with the 'Reliapage' feature.    Messages can be requeued    by user for a reliapage range, or by 
range of time.    Choose 'Requeue Messages' from the 'Tools' menu to use this feature.    Choose a user from the list 
presented to you by double-clicking on the username, or by highlighting the user and clicking on the 'Requeue' 
button.    The next screen will allow you to choose to requeue messages by 'Reliapage Number' or by 'Date & Time'.    
After entering the required information, click on the 'Apply' button to requeue all messages that meet the criteria.



Cancel Messages

Messages that are queued and waiting to be sent can be cancelled from within the Admin program.    Choose 'Cancel 
Messages' from the 'Tools' menu to use this option.    Choose a user from the list presented to you by double-clicking 
on the username or by highlighting the user and clicking on the 'Cancel' button.    All pending messages for the user 
will be canceled.



Import

PageGate can import program settings, carriers, users, or groups from a text file generated by the 'Export' function.    
The 'Import' option is found under the 'Tools' menu.    You must then select what information is to be imported from the
'Import' menu.    You will then be given a file system dialog box to use to find the file to be imported.    Note:    be sure 
to make a backup of your database (pagegate.mdb) before importing information.



Export

PageGate can export program settings, carrier, users, or groups to a text file.    This file can then be used by the 
'Import' function.    The 'Export' option is found under the 'Tools' menu.    You must then select what information is to 
be exported from the 'Export' menu.    You will then be given a file system dialog box to use to specify the filename 
and location for the export file.



Clear Locks

PageGate's modules can be run across sever machines in a high volume application.    Each module is kept track of 
via a series of 'locks'.    If one of PageGate's modules is terminated abnormally, the lock may be left in place.    You will
then receive an error when you restart the module.    If you are positive that another copy of a particular module is not 
running, you can clear the lock from within the PageGate Admin program.    Choose 'Clear Locks' from the 'Tools' 
menu.    Click on the button corresponding to the module you are having the problem with.    Only modules with active 
locks are highlighted.    After you click on a button, it should become disabled (grayed-out).



Rebuild Database

Power failures, hardware faults, and user error can adversely affect a database file.    PageGate's database can 
become damaged as a result of these events.    The 'Rebuild Database' option can correct most problems resulting 
from the above causes.    Be sure all modules are stopped and all users are off the system before running a rebuild.    
The 'Rebuild Database' option is found under the 'Tools' menu of the Admin program.    If the 'Rebuild Database' 
function is unable to correct you problem.    You may be able to correct the problem by exporting your data (see 
'Export'), deleting the database (after making a backup of course), shutting down and restarting PageGate (which will 
create a new blank database), and importing your data (see 'Import').    This should not be attempted, however, 
without first contacting NotePage tech support.    Note: be sure to make a backup of your database (pagegate.mdb) 
before rebuilding the database.



Overview

A carrier needs to be setup for each service provider you use for paging service.    Among other things, the carrier 
setup screen contains the phone number and modem settings to connect to the paging carrier's paging terminal.    
Large paging service providers may have several paging terminals that cover different geographical areas.    For 
these providers, you will need to setup a separate carrier entry for each individual paging terminal.    At least one 
carrier must be setup in PageGate for messages to be processed.



Add Carrier

At least one carrier must be entered into PageGate for it to operate.    A carrier must be setup for each 
individual phone number dialed to connect to a paging terminal.    Large paging service providers may 
have more than one phone number, depending on the service area covered.    More than one carrier 
would need to be entered (for a single service provider) in this case.    To add a carrier, choose 'Add' form 
the 'Carrier' menu.    The 'Add Carrier' window will appear.

Carrier
Enter a short name to identify the carrier.

Phone Number
Enter the phone number of the paging carrier's terminal.    Be sure to include any dialing prefixes needed for 
an outside line or long distance.

Baud Rate
Enter the baud rate needed to connect to the paging terminal.    This value should be obtained from your 
paging service provider.    1200 baud is the most common setting.

Parity
Enter the parity needed to connect to the paging terminal.    This value should be obtained from your paging 
service provider.    'e' parity is the most common setting.

Data Bits
Enter the data bits needed to connect to the paging terminal.    This value should be obtained from your 
paging service provider.    7 data bits is the most common setting.

Stop Bits
Enter the stop bits needed to connect to the paging terminal.    This value should be obtained from your 
paging service provider.    1 stop bit is the most common setting.

Init String
Depending on the modem you are using, and the modem your paging carrier is using, you may need to 
specify a modem init string to be sent each time you call this carrier.    See the 'Init String' section under 
'Troubleshooting' for detailed information about init string.

Max Chars
This sets the maximum number of character your carrier will accept in a single message.    You should obtain
this value from your paging service provider.    Messages that are longer than this value will be broken up 
into individual messages of this length.    They will be numbered 1ofX, 2ofX, 3ofX, etc.    To actually limit the 
total size of messages sent, set the 'Max Chars' setting under the 'Users' screen.

Password
Some paging carriers require a password to connect to their paging terminal.    Enter the password here.    
Most carriers do not use passwords.

Pulse Dial
Check this option if you don't have touch tone service on the phone line you are dialing out on.

Direct Connect
Check this option if your connection to this carrier's paging terminal is via a direct cable connection.

Tone Msgs
Check this option if you want this carrier to be used to send touch-tone messages to numeric pagers.    
Please see the section on 'Sending Touch Tone Messages to Numeric Pagers' in the following section about 
setting up users.

Tone Wait String
This is the wait string used when sending touch-tone messages to numeric pagers.    The default string is 
',,@'.    Please see the section on 'Sending Touch Tone Messages to Numeric Pagers' in the following section
about setting up users.





Edit Carrier

Existing carriers can be edited by choosing 'Edit' from the 'Carrier' menu.    The only value that can't be changed is the
carrier's name.    From the first window, you must choose a carrier to edit.    Select a carrier by double-clicking on the 
carrier's name, or by highlighting the carrier and clicking on the 'Edit' button.    The next window displayed will allow 
you to edit the carrier's settings.

Phone Number
Enter the phone number of the paging carrier's terminal.    Be sure to include any dialing prefixes needed for 
an outside line or long distance.

Baud Rate
Enter the baud rate needed to connect to the paging terminal.    This value should be obtained from your 
paging service provider.    1200 baud is the most common setting.

Parity
Enter the parity needed to connect to the paging terminal.    This value should be obtained from your paging 
service provider.    'e' parity is the most common setting.

Data Bits
Enter the data bits needed to connect to the paging terminal.    This value should be obtained from your 
paging service provider.    7 data bits is the most common setting.

Stop Bits
Enter the stop bits needed to connect to the paging terminal.    This value should be obtained from your 
paging service provider.    1 stop bit is the most common setting.

Init String
Depending on the modem you are using, and the modem your paging carrier is using, you may need to 
specify a modem init string to be sent each time you call this carrier.    See the 'Init String' section under 
'Troubleshooting' for detailed information about init string.

Max Chars
This sets the maximum number of character your carrier will accept in a single message.    You should obtain
this value from your paging service provider.    Messages that are longer than this value will be broken up 
into individual messages of this length.    They will be numbered 1ofX, 2ofX, 3ofX, etc.    To actually limit the 
total size of messages sent, set the 'Max Chars' setting under the 'Users' screen.

Password
Some paging carriers require a password to connect to their paging terminal.    Enter the password here.    
Most carriers do not use passwords.

Pulse Dial
Check this option if you don't have touch tone service on the phone line you are dialing out on.

Direct Connect
Check this option if your connection to this carrier's paging terminal is via a direct cable connection.

Tone Msgs
Check this option if you want this carrier to be used to send touch-tone messages to numeric pagers.    
Please see the section on 'Sending Touch Tone Messages to Numeric Pagers' in the following section about 
setting up users.

Tone Wait String
This is the wait string used when sending touch-tone messages to numeric pagers.    The default string is 
',,@'.    Please see the section on 'Sending Touch Tone Messages to Numeric Pagers' in the following section
about setting up users.



Delete Carrier

Carriers that are no longer needed can be deleted by choosing the 'Delete' option under the 'Carrier' menu.    You will 
be given a list of existing carriers to choose from.    Choose a carrier to delete by double-clicking on the carrier's 
name, or by highlighting the carrier and clicking on the 'Delete' button.    As a safety precaution, PageGate will not 
allow you to delete a carrier that has active users.    You must delete all users using a carrier before you can 
delete the carrier.



Overview

In PageGate a user is setup for each pager (or other wireless messaging device) you want to send messages to.    
Throughout the documentation, a pager will be referred to by the user account setup for that pager.    At least one 
user must be setup in PageGate for messages to be processed.



Add User

At least one user (pager) must be entered into PageGate for it to operate.    A user is setup for each pager you want to
send messages to.    Choose 'Add' from the 'User' menu to add an new user.    The 'Add User' windows will appear.

User
Enter a short username for the pager here.

Full Name
Enter the full name of the owner of the pager here.

ID
Enter the ID (PIN) number of the pager here.    ID numbers are usually seven digits long.    the ID may be the
phone number of your pager, or a totally different number altogether.    You must obtain this number from 
your paging carrier in order to send messages to the pager.

Carrier
Select the carrier for this pager from the drop-down list

Forward To
If you would like a copy of the each message for this user forwarded to an email address, enter it here.    The
GetMail module must be running for this option to work.

Max Chars
This is the maximum number of character that is to be sent to this pager in a single message.

Notify Code
This is the numeric code sent to numeric pager when they are sent a text message.    This code is also sent 
to alphanumeric pagers if the 'Notify Only' option is checked.

Alpha
Check this box if the pager is an alphanumeric model (can display letters and numbers).

Notify Only
Check this box if you want the 'Notify Code' sent to the pager instead of the actual message.    This is 
commonly used with numeric pagers to notify the user the they have received a text message.

Reliapage
Check this box if you want messages sent to this pager numbered sequentially.    This would allow the user 
to know if any messages have been missed.

Enabled Services
Check each service you want this user to be able to receive messages from.

Advanced Options
Maintain Mailbox – check this box if you want PageGate to maintain an email mailbox on the web server, for 

this user.
Email Outcome – check this box if you want and email reply sent back to the sender of mail messages with 

the success/failure of the message being sent by PageGate.
Remove Sender's Domain – check this box if you want the sender's domain name stripped from the from 

field when the message is sent to the paging terminal.
Multi-Page – check this box if this user is to be a Multi-Page user. See the Concepts or Reference sections 

of this manual for more information.
Ad-Hoc – check this box if this user is to be an Ad-Hoc user.    See the Concepts or Reference sections of 

this manual for more information.

Web Page
Click the 'Web Page' button to create a web page for this user.    See GetWeb under the Modules section of 
this manual for detailed information on creating web pages.



Edit User

Existing users can be edited by choosing 'Edit' from the 'User' menu.    The only value that can't be changed is the 
user's name.    From the first window, you must choose a user to edit.    Select a user by double-clicking on the user's 
name, or by highlighting the user and clicking on the 'Edit' button.    The next window displayed will allow you to edit 
the user's settings.

Full Name
Enter the full name of the owner of the pager here.

ID
Enter the ID (PIN) number of the pager here.    ID numbers are usually seven digits long.    the ID may be the
phone number of your pager, or a totally different number altogether.    You must obtain this number from 
your paging carrier to be able to send messages to the pager.

Carrier
Select the carrier for this pager from the drop-down list

Forward To
Forward To
If you would like a copy of the each message for this user forwarded to an email address, enter it here.    The
GetMail module must be running for this option to work.

Max Chars
This is the maximum number of character that is to be sent to this pager in a single message.

Notify Code
This is the numeric code sent to numeric pager when they are sent a text message.    This code is also sent 
to alphanumeric pagers if the 'Notify Only' option is checked.

Alpha
Check this box if the pager is an alphanumeric model (can display letters and numbers).

Notify Only
Check this box if you want the 'Notify Code' sent to the pager instead of the actual message.    This is 
commonly used with numeric pagers to notify the user the they have received a text message.

Reliapage
Check this box if you want messages sent to this pager numbered sequentially.    This would allow the user 
to know if any messages have been missed.

Enabled Services
Check each service you want this user to be able to receive messages from.

Advanced Options
Maintain Mailbox – check this box if you want PageGate to maintain an email mailbox on the web server, for 

this user.
Email Outcome – check this box if you want and email reply sent back to the sender of mail messages with 

the success/failure of the message being sent by PageGate.
Remove Sender's Domain – check this box if you want the sender's domain name stripped from the from 

field when the message is sent to the paging terminal.
Multi-Page – check this box if this user is to be a Multi-Page user. See the Concepts or Reference sections 

of this manual for more information.
Ad-Hoc – check this box if this user is to be an Ad-Hoc user.    See the Concepts or Reference sections of 

this manual for more information.

Web Page
Click the 'Web Page' button to create a web page for this user.    See GetWeb under the Modules section of 
this manual for detailed information on creating web pages.



Delete User

Users that are no longer needed can be deleted by choosing the 'Delete' option under the 'User' menu.    You will be 
given a list of existing users to choose from.    Choose a user to delete by double-clicking on the user's name, or by 
highlighting the user and clicking on the 'Delete' button.    PageGate will briefly stop and then restart all of PageGate's
modules while the user is being deleted.    This prevents messages that are actively being sent for that user to 
become corrupted.    If you are deleting may users, it may be quicker to manually stop PageGate's modules, delete 
the users, and then restart the modules.



Overview

In PageGate, users can be entered into a group.    The group can then be sent messages as if it were a single user.    
However, in this case all the users in the group will receive the message.    Groups can also contain other groups.    
This is a handy feature, but be careful not to create a circle by including the original group in a sub group.    This 
would create an unending repeating loop of messages.    Groups are optional and need not be setup for PageGate to 
operate.



Add Group

Groups can be setup to allow a single message to be sent to several users (pagers).    To add a new group, choose 
'Add' from the 'Group' menu.    The 'Add Group' window will be displayed.    After a group is created users can be 
added to the group using the 'Maintain' option under the 'Group' menu.

Group
Enter a short name for the group

Description
Enter a longer description of the group

Forward To
If you would like a copy of the each message for this group forwarded to an email address, enter it here.    
This setting does not change the forwarding setup for each user in the group.    The forwarding setting for 
each individual user in the group will be applied individually to the message sent to each user.    The GetMail 
module must be running for this option to work.

Enabled Services
Check each service you want this group to be able to receive messages from.

Advanced Options
Maintain Mailbox – check this box if you want PageGate to maintain an email mailbox on the web server, for 

this group.

On-Call Group - check this box if you want to user the on-call feature for this group.    See On-Call in the 
Concepts or Reference section of this manual for more detailed information. 

Web Page
Click the 'Web Page' button to create a web page for this group.    See GetWeb under the Modules section of
this manual for detailed information on creating web pages.



Edit Group

Existing groups can be edited by choosing 'Edit' from the 'Group' menu.    The only value that can't be changed is the 
group's name.    From the first window, you must choose a group to edit.    Select a group by double-clicking on the 
group's name, or by highlighting the group and clicking on the 'Edit' button.    The next window displayed will allow you
to edit the group's settings.

Description
Enter a longer description of the group

Forward To
If you would like a copy of the each message for this group forwarded to an email address, enter it here.    
This setting does not change the forwarding setup for each user in the group.    The forwarding setting for 
each individual user in the group will be applied individually to the message sent to each user.    The GetMail 
module must be running for this option to work.

Enabled Services
Check each service you want this group to be able to receive messages from.

Advanced Options
Maintain Mailbox – check this box if you want PageGate to maintain an email mailbox on the web server, for 

this group.

On-Call Group - check this box if you want to user the on-call feature for this group.    See On-Call in the 
Concepts or Reference section of this manual for more detailed information. 

Web Page
Click the 'Web Page' button to create a web page for this group.    See GetWeb under the Modules section of
this manual for detailed information on creating web pages.



Delete Group

Groups that are no longer needed can be deleted by choosing the 'Delete' option under the 'Group' menu.    You will 
be given a list of existing groups to choose from.    Choose a group to delete by double-clicking on the group's name, 
or by highlighting the group and clicking on the 'Delete' button.    PageGate will briefly stop and then restart all of 
PageGate's modules while the group is being deleted.    This prevents messages that are actively being sent for that 
group to become corrupted.    If you are deleting many groups, it may be quicker to manually stop PageGate's 
modules, delete the groups, and then restart the modules.



Group Maintenance

Once a group is created, users can be added to it by using the 'Maintain Groups' screen.    To access the 'Maintain 
Groups' screen, choose 'Maintain' from the 'Group' menu.    Choose the group you wish to modify from the drop-down 
list labeled 'Group'.    The box on the left will show all users that are not already a member of this group.    The box on 
the right will show all users already members of this group.    To move a user from one list to the other, simply click on 
the user's name.    Once all the necessary changes are made to a group, you must click the 'Apply' button before 
choosing another group to modify.    Click on the 'Close' button when all changes are made and applied.



Logs

Several logs are generated by PageGate during its normal operation.    You can choose to enable or disable these 
logs from the 'Setup' screen.    PageGate's 'General' log contains information about messages rejected by its front-
end modules, the scheduler, or the dialers.    It also contains information about messages that have been successfully
sent or have failed while being sent.    The dialer detail logs contain detailed information about the conversation 
between the dialer, the modem, and the paging terminal.    All the logs can be accessed by choosing 'View Log' from 
the 'Report' menu.



Carrier List

A list of all active carriers and their settings can be printed from within PageGate's Admin program.    Choose 'Carrier 
List' from the 'Reports' menu to access this option.    You will be given a printer dialog box to choose what printer you 
want the report printed to.    The report will then print.



User List

A list of all active users and their settings can be printed from within PageGate's Admin program.    Choose 'User List' 
from the 'Reports' menu to access this option.    You will be given a printer dialog box to choose what printer you want 
the report printed to.    The report will then print.



Message Count

A report that shows how many messages have been sent to each user within a certain time period can be generated 
by PageGate's Admin program.    To print this report, choose 'Message Count' from the 'Report' menu.    You will be 
given a screen where you can enter the starting and ending date for the report.    There is also an option to include 
users even if no messages have been sent within the time period.    Next you will be given a printer dialog box to 
choose which printer to send the report to.    The report will then print.



Registering PageGate

PageGate defaults to a 'shareware mode' until it is registered (purchased).    The shareware version only allows for 
two users to be setup.    In addition, PageGate's modules will stop themselves every 3 to 5 days until they are 
registered.    Registration for all of PageGate's modules is done at one place.    To display the registration screen, 
choose 'Register' from the 'Help' menu.    The 'Registration Information' screen will appear.    Type in your registration 
you received from NotePage, Inc. word for word, and letter for letter.    It must be typed exactly for the registration 
to be accepted.    For pricing or more information on registering PageGate, please contact NotePage, Inc.



General Troubleshooting Techniques

The first step to solving problems in PageGate is to turn on its logging capability.    Go to 'Tools' -> 'Setup' -> 'Admin' 
(tab).    Check both 'Log to Disk' and 'Detailed Log'.    The 'Log to Disk' option enables PageGate's general (summery) 
log.    It can be viewed by choosing 'Reports' -> 'View Log' -> 'General'.    This log includes information about all 
rejected, successful, and failed messages.
A separate detailed log is maintained for each dialer (if multiple dialers are in use).    The 'Engine' is also known as 
'Dialer1'.    The log for Dialer2 is 'Dialer2' etc.    The detailed logs maintain detailed information about the conversation 
of PageGate with your carrier's paging terminal.
Analyzing these logs can in most cases point to where the problem resides.    As a last resort, a low level modem 
monitor tool is also available for the first dialer (Engine).    It shows the actual data being sent and received by your 
modem.    This option should be used with the aid of NotePage, Inc. tech support personnel.    The tool is designed for
diagnostics purposes only, and is not meant to be left active for long periods of time.    The modem monitoring tool 
can be activated by creating a file named 'modem.dbg' and putting it in the same directory as the 'pgengine.exe' 
(found by default in the PageGate program directory) executable file.    The content of the file is unimportant.



Messages aren't being acknowledged by either the scheduler or the dialers (Engine)

The scheduler module and the dialer modules currently only support US date format (mm/dd/yy).    Check your date 
format setting in the your control panel under 'Regional Settings' to be sure this is the current format.



PageGate stopped sending messages at the end of the month

The scheduler module and the dialer modules currently only support US date format (mm/dd/yy).    Check your date 
format setting in the your control panel under 'Regional Settings' to be sure this is the current format.



When I start PageGate, one (or more) of the modules says that it is already running, but it isn't.

PageGate is capable of running its modules across several separate machines for a high end configuration.    It keeps
track of each separate module with a series of    'locks'.    If you are positive that another copy of a particular module 
isn't running, you can clear the lock from within the PageGate Admin program.    Choose 'Clear Locks' from the 'Tools' 
menu.    Click on the button corresponding to the module you are having the problem with.    Only modules with active 
locks are highlighted.    After you click on a button, it should become disabled (grayed-out).



I receive the error 'Error Talking to Modem... Invalid Port Number'

1. Go to 'Tools' -> 'Setup' -> 'Engine' (tab) and check to be sure your modem (engine) com port is set correctly.

2. If you have an external modem, make sure it is connected and turned on.

3. There may be another program running on your machine that is using 
the modem.    For example, you will get this error if you have a fax program running in the background waiting to 
receive faxes, or you may have a remote control program such as PCAnywhere running in the background waiting for
a call.    PageGate requires exclusive use of the modem.



My modem doesn't dial

Check the detailed log.    If it says 'No Dialtone', then check your phone line connections.    Also be sure you don't 
require a dialing prefix to obtain an outside line.    If the log says 'Sending Init String' and the very next line says 
'Resetting Modem', this means your modem is rejecting the 'Init String' you entered for the carrier being dialed.    
Check for typing errors in the init string, or try another string that may work with your modem.    See 'Init Strings' below
for more information.



I hear my modem dial, but no messages are sent.    The detailed log says 'No Carrier or Cancelled by User'

1. Make sure you have included any dialing prefixes needed to get an outside line and dial long distance if necessary.

2. You may not have the correct phone number for your paging carrier's terminal.    Try dialing the phone number with 
a regular phone.    If you don't hear a long high pitched (computer) tone, you have the wrong number.

3. If #2 above does give you a computer tone, you need an init string (or a different one) to connect to the paging 
terminal's modem.    See 'Init Strings' below for more information



My modem connects, but the detailed log says 'No ID Prompt Received'

1. Check your 'Baud Rate', 'Parity', 'Data Bits', and 'Stop Bits' settings with your paging carrier.    The most commonly 
used settings are 1200,e,7,1.

2. You may need to use an init string (or a different one).    See 'Init Strings' below for more information



My modem does not hang up after sending a message.

You may need to use an init string (or a different one) with your modem.    See 'Init Strings' below for more 
information.



I have a USRobotics (3Com) modem.    I have tried the init string but I still get inconsistent results.

Some model USRobotics (3Com) modems have difficulty communicating with the computer at low baud rates (i.e. 
under 9600 baud).    Try setting the baud rate on the carrier setup screen to 19200.    Also use the init string given to 
lock the baud rate between the modems to a lower rate.



What is an init string?

Different modems don't necessarily talk to each other as setup right out of the box.    Modems use many different 
settings and protocols.    In order for two modems to communicate, they must agree on many things such as speed, 
error correction, compression algorithms, etc...    By sending a modem an init string, you can control some of these 
parameters.



What do I need to put in my init string?

In general, the modems used by paging carriers run at a speed from 300 to 2400 baud (1200 being the most 
common).    They don't typically use any form of error correction or data compression protocols.    In many cases, if 
your modem tries to use either of these protocols, your modem will be unable to communicate with the paging 
terminal's modem.    In your init string you should include settings to lock you modem's baud rate to that of your 
carrier's modem, disable error correction protocols, and disable data compression protocols.    In addition PageGate 
you like you modem to issue English response codes (rather than numeric response codes), and issue complete 
connection information.



Do all modems use the same init string?

No, many different modem manufacturers use their own set of init string.    Init string may even be different between 
models by the same manufacturer.



My init string works on one carrier but not the other.

You may need a different init string to connect to each carrier.    In general your init strings will be the same, but not 
always.



What init string should I use?

There is no easy answer to that question.    In general, if your modem is a 2400 baud model or slower (very old 
models) you won't need an init string.    These older modems sometimes work best when communicating with the 
paging terminals.    Anything faster (9600, 14.4, 28.8, 33.6, 56K, etc.), will probably require an init string.    Some of the
most common init strings are listed below.    If you have a less well known brand modem, you may need to use the 
documentation included with you modem to create an init string.



I've tried everything, but I still can't connect to my paging carrier's terminal.

1. If you have access to an different model modem (the older the better), give it a try.

2. If you user more than one paging carrier, try connecting to the second carrier to verify the operation of your modem
and phone line connection.

3.    Fax or email us the section of your modem's manual with the init string settings in it.    Also include the phone 
number you are dialing for your carrier, and all the other setting on the carrier setup screen.    Email to 
tech@notepager.net, or fax to (781) 826-3432.



Common Init Strings
 

AT&FQ0V1X4&D2      - Minimal settings.    Works with most 1200 and 2400 baud modems. Some modems use 
&F0 rather than &F.    All '0' are zeros not ohs.

AT&FQ0V1X4&D2N0S37=5      - Hard coded baud rate.    Works with many 14.4 and 28.8 modems.    The added 
codes locks the connection baud rate to 1200 baud.    Use S37=3 for a 300 baud connection, and S37=6 for a 2400 
baud connection.    Some modems use &F0 rather than &F.    All '0' are zeros not ohs. 

AT&FQ0V1X4&D2N0S37=5\N0%C0      - No compression/error correction.    Works with many 14.4, 28.8 and 33.6
modems.    The added codes turn off data compression and error correction.    You can try using only one of the two 
additional codes (\N0 or %C0) if you modem rejects using both.    Use S37=3 for a 300 baud connection, and S37=6 
for a 2400 baud connection.    Some modems use &F0 rather than &F.    All '0' are zeros not ohs.

AT&F0Q0V1X4&D2&B1&K0&M0&N2      - USRobotics (3Com) string.    Works with most USRobotics/3Com 33.6 
and 56K modems (and some others too).    Use &N1 (instead of &N2) for a 300 baud connection, or &N3 for a 2400 
baud connection.

More init strings may be available on our web site: www.notepager.net



What is an init string?

Different modems can't necessarily talk to each other as setup right out of the box.    Modems use many different 
settings and protocols.    In order for two modems to communicate, they must agree on many things such as speed, 
error correction, compression algorithms, etc...    By sending a modem an init string, you can control some of these 
parameters.



What do I need to put in my init string?

In general, the modems used by paging carriers run at a speed from 300 to 2400 baud (1200 being the most 
common).    They don't typically use any form of error correction or data compression protocols.    In many cases, if 
your modem tries to use either of these protocols, your modem will be unable to communicate with the paging 
terminal's modem.    In your init string you should include settings to lock you modem's baud rate to that of your 
carrier's modem, disable error correction protocols, and disable data compression protocols.    In addition PageGate 
would like your modem to issue English response codes (rather than numeric response codes), and issue complete 
connection information.



Do all modems use the same init string?

No, many different modem manufacturers use their own set of init string.    Init string may even be different between 
models by the same manufacturer.



My init string works on one carrier but not the other.

You may need a different init string to connect to each carrier.    In general your init strings will be the same, but not 
always.



What init string should I use?

There is no easy answer to that question.    In general, if your modem is a 2400 baud model or slower (very old 
models) you won't need an init string.    These older modems sometimes work best when communicating with the 
paging terminals.    Anything faster (9600, 14.4, 28.8, 33.6, 56K, etc.), will probably require an init string.    Some of the
most common init strings are listed below.    If you have a less well known brand modem, you may need to use the 
documentation include with you modem to create an init string.



I've tried everything, but I still can't connect to my paging carrier's terminal.

1. If you have access to an different model modem (the older the better), give it a try.

2. If you user more than one paging carrier, try connecting to the second carrier to verify the operation of your modem
and phone line connection.

3.    Fax or email us the section of your modem's manual with the init string settings in it.    Also include the phone 
number you are dialing for your carrier, and all the other setting on the carrier setup screen.    Email to 
tech@notepager.net, or fax to (781) 826-3432.



Common Init Strings
 

AT&FQ0V1X4&D2      - Minimal settings.    Works with most 1200 and 2400 baud modems. Some modems use 
&F0 rather than &F.    All '0' are zeros not ohs.

AT&FQ0V1X4&D2N0S37=5      - Hard coded baud rate.    Works with many 14.4 and 28.8 modems.    The added 
codes locks the connection baud rate to 1200 baud.    Use S37=3 for a 300 baud connection, and S37=6 for a 2400 
baud connection.    Some modems use &F0 rather than &F.    All '0' are zeros not ohs. 

AT&FQ0V1X4&D2N0S37=5\N0%C0      - No compression/error correction.    Works with many 14.4, 28.8 and 33.6
modems.    The added codes turn off data compression and error correction.    You can try using only one of the two 
additional codes (\N0 or %C0) if you modem rejects using both.    Use S37=3 for a 300 baud connection, and S37=6 
for a 2400 baud connection.    Some modems use &F0 rather than &F.    All '0' are zeros not ohs.

AT&F0Q0V1X4&D2&B1&K0&M0&N2      - USRobotics (3Com) string.    Works with most USRobotics/3Com 33.6 
and 56K modems (and some others too).    Use &N1 (instead of &N2) for a 300 baud connection, or &N3 for a 2400 
baud connection.

More init strings may be available on our web site: www.notepager.net



Log to Disk

Enables/Disables PageGate's general log.    The general log contains rejected, successful, and failed message 
information.



Detailed Log

Enables/Disables PageGate's detailed logs.    Each dialer has it's own detailed log.    It contains detailed information 
about the dialer's conversations with the paging carrier's terminals.



Polling Interval

This sets how often the modules check for new messages and update their status screens.    A short interval is less 
likely to queue up messages and deliver them during one connection.    A long interval will queue more messages for 
delivery but may can delay the time it takes for a user to receive a message.    A setting of 5 is the default.



Log Length

This sets how many lines will be kept in the log files.    The logs are trimmed to this length each night.



Purge After

This sets how long sent messages are kept in the PageGate database before they are deleted.



Dial Threshold

This sets how many messages must be in the queue before an additional dialer is started to aid in delivering the 
messages.    This setting only has relevance if you own more than one dialer.



Retries

This sets how many times a carrier is redialed before all the messages pending for that carrier are marked as bad.    A
value of zero means infinite number of retries.



Retry Interval

This sets (in seconds) how long to wait between retries when unable to connect to a carrier.



Engine Port

This sets the com port for the modem to be used by the Engine (Dialer1).



Dialer Port

This sets the com port for the modem to be used by each of the additional dialers. Real labels are Dialer2 Port, 
Dialer3 Port, and Dialer4 Port.



Engine is Direct Connect

This sets the Engine (Dialer1) to direct connect mode.    Meaning, the Engine (Dialer1) has a direct cable connection 
the a paging terminal and doesn't use a modem.



Carrier

A short name to identify the carrier.



Phone Number

The phone number of the paging carrier's terminal.    Be sure to include any dialing prefixes needed for an outside line
or long distance.
 



Baud Rate

The baud rate needed to connect to the paging terminal.    This value should be obtained from your paging service 
provider.    1200 baud is the most common setting.



Parity

The parity needed to connect to the paging terminal.    This value should be obtained from your paging service 
provider.    'e' parity is the most common setting.



Data Bits

The number of data bits needed to connect to the paging terminal.    This value should be obtained from your paging 
service provider.    7 data bits is the most common setting.



Stop Bits

The number of stop bits needed to connect to the paging terminal.    This value should be obtained from your paging 
service provider.    1 stop bit is the most common setting.



Max Chars - Carrier Field

This sets the maximum number of character your carrier will accept in a single message.    You should obtain this 
value from your paging service provider.    Messages that are longer than this value will be broken up into individual 
messages of this length.    They will be numbered 1ofX, 2ofX, 3ofX, etc.    To actually limit the total size of messages 
sent, set the 'Max Chars' setting under the 'Users' screen.



Password

Some paging carriers require a password to connect to their paging terminal.    Enter the password here.    Most 
carriers do not use passwords.



Pulse Dial

Check this option if you don't have touch tone service on the phone line you are dialing out on.



Direct Connect

Check this option if your connection to this carrier's paging terminal is via a direct cable connection.



User

A short username for the pager.



Full Name

The full name of the owner of the pager (messaging device).



ID

The ID (PIN) number of the pager (messaging device).    ID numbers are usually seven digits long.    the ID may be 
the phone number of your pager, or a totally different number altogether.    You must obtain this number from your 
paging carrier to be able to send messages to the pager.



Forward To

Not applicable to NotePager Net



Max Chars - User Field

This is the maximum number of character that is to be sent to this pager in a single message.



Notify Code

This is the numeric code sent to numeric pager when they are sent a text message.    This code is also sent to 
alphanumeric pagers if the 'Notify Only' option is checked.



Alpha

Check this box if the pager (messaging device) is an alphanumeric model (can display letters and numbers).



Notify Only

Check this box if you want the 'Notify Code' sent to the pager instead of the actual message.    This is commonly used
with numeric pagers to notify the user the they have received a text message.



Reliapage

Check this box if you want messages sent to this pager numbered sequentially.    This would allow the user to know if 
any messages have been missed.



Enabled Services

For NotePager Net, only the 'GUI' service box should be checked.



Advanced Options

Not applicable to NotePager Net.



Web Page

Not applicable to NotePager Net



Group

A short name to identify the group



Description - Group

A longer description of the group.    This field is similar to the 'Full Name' field on the user setup screen.



I can't start the scheduler or engine.    They are greyed-out.

At least one carrier and one user must be setup in the Admin program before the scheduler and engine buttons are 
made active.



Setup Overview

There are two stages to the setup of NotePager Net.    The first stage is the setup of PageGate, NotePager Net's 
paging server application.    The PageGate server must be installed, setup, and running in order to use NotePager 
Net.    It should be installed and setup before attempting to run NotePager Net for the first time.    The second stage is 
the setup of the NotePager Net client application.

NotePager Net sends to and receives information from PageGate via a shared database file (pagegate.mdb).    
During the setup of PageGate you are prompted for a location for this file.    The file should be placed at a location 
where both the PageGate server and the NotePager Net client can access the file.    In other words, the database file 
(pagegate.mdb) should be in a shared network folder to which both NotePager Net and PageGate have full rights.    
The default location for this file is PageGate's program directory.    To keep the file there and use NotePager Net, you 
must share the PageGate program folder on your network.

During the setup of NotePager Net you are prompted for the 'PageGate Directory'.    You must enter (or browse using 
the button with three dots) the full path to the pagegate.mdb file.    If the machine you installed PageGate on was 
called 'pgserver', and you installed PageGate to a drive shared as c-drive, and the database was installed in it's 
default location, the full path would be:

\\pgserver\c-drive\program files\pagegate\



Carrier

A carrier is the company you pay for your pager service.    They control the antennas, satellites, broadcast, and 
computer systems that are used to send the messages to your pager.    You may purchase your paging service from a
reseller who represents several paging carriers.    They resell the paging service, but are not actually the paging 
carrier.    When setting up PageGate, you will need some information about the actual carrier that your pager is 
serviced by (see the installation part of the documentation for specifics).



Group

Groups can be created to help when sending the same message to many pagers.    After a group is created you can 
add several users (or other groups) into the group's member list.    Messages can be sent to a group in exactly the 
same way messages are sent to individual pagers.    The message, however, is delivered to all the members of the 
group.    *Note: be careful not include any groups within a group that has the original group as a member.    This would
create a never-ending circle of pages.



Initialization strings

In summary, many modems need an initialization string to allow them to connect to a paging carrier.    Init strings can 
be different for different modems (even from the same manufacturer), and can be different for each carrier you 
connect to.    Please refer to the installation and troubleshooting sections for detailed information about initialization 
strings.



Message Content

Messages sent by PageGate are sent with more information than just the message itself.    Messages will be prefixed 
with the reliapage index (if enabled), the block number (if it is part of a large message that has been broken into 
smaller pieces.    i.e. 1 of 3, 2 of 3, 3 of 3), the sender's name, the subject of the message (optional), and then the 
message itself.    Each of these fields is separated with a colon (:).    Most pagers have a limited character set usually 
consisting of upper and lower case letters, numbers, and some symbols (periods, commas, dollar signs, exclamation 
points, etc.).    Non printing characters such as carriage returns, line feeds, tabs, and such are usually not supported 
along with some symbols.



Message Length

PageGate sends your messages to your paging carrier in blocks of 240 characters.    If you have specified a larger 
limit for a user, the message will be broken up into multiple blocks of 240 characters.    The blocks will be numbered 
(i.e. 1 of 3, 2 of 3, 3 of 3) and sent sequentially.    The numbering of messages is important because, although 
PageGate sends the messages in the correct order to the paging carrier, the messages may not be received by the 
pager in the same order (this is possible due to the way the paging systems operate).



Notify Only

Users in PageGate can be set as 'Notify Only'.    When this option is enabled, a predefined (settable) numeric 
message (notification code) is sent instead of the actual message.    This is most commonly used to notify a user with 
a numeric pager that an email message or a message from the www has been received (PageGate's email or web 
gateways must be running to receive email or www messages).



Numeric (digital) Pagers

Some pagers are only capable of displaying numbers (no letters).    These are commonly called numeric or digital 
pagers (beepers).    PageGate fully supports numeric pagers.    If a message is sent to a numeric pager, and the 
message contains letters, the user's notification code (999 by default) is sent instead.    This alerts the user that they 
have been sent a message that was alphanumeric in nature, and they should take steps to retrieve the actual 
message.    *Note: this option is very popular with PageGate's email gateway.    Users with numeric pagers can be 
notified if they receive an email message (Email Notification).    They can then connect to the Internet and check their 
email.



On-Call Group

PageGate has built into it a feature than can be very useful in an on-call service environment.    A schedule of users 
can be setup defining when a user is on-call (starting day and time, and ending day and time).    These users are then
added to a group that has been defined as an on-call group.    When a message is sent to the group, the schedule is 
consulted to see which user or users the page should be sent to.    That way, only the users that are scheduled to be 
on-call receive the page.



Pager (Beeper)

Throughout PageGate's documentation the word 'pager' used.    'Pager' is better defined as 'paging device'.    
PageGate can be used to send messages to many devices other than pagers.    For example messages can be sent 
to digital/cellular/mobile/pcs phones, pager cards for portable computers, Personal Information Managers (PIMs), 
billboards, and many other wireless messaging devices.



Reliapage

As you are probably aware, paging uses a one-way transmission.    There is no confirmation sent back from the pager
that messages have (or have not) been received.    In poor coverage areas, messages can be, and are missed.    
PageGate's Reliapage option sequentially numbers each message sent out.    A numbering sequence is maintained 
for each individual user.



Repeating Pages

PageGate allows you to send a repeating message.    The message's start date and time is set.    A repeat interval is 
set (repeat every ? minutes, hours, and days).    Then a stop date and time is set.    This option is currently only 
available when using the NotePager Net (GUI) client application.



Scheduled Pages

PageGate allows you to schedule a message to be sent at a future date and time.    This option is currently only 
available when using the NotePager Net (GUI) client application.



User

In PageGate, 'user' is synonymous with 'pager'.    A user is the person who carriers the actual pager.    When 
PageGate refers to a 'user' it is really referring to the user's pager.    This approach simplifies things for the end users. 
For example if a user were to replace their pager with a new unit, the user name will stay consistent, even though the 
pager's information would change.



Log Files

PageGate can be set to keep a general log of all messages sent and all messages rejected by PageGate.    A detailed
log option is also available. When enabled, it will keep a detailed log of each modem's connection with the carriers it 
dials, and messages it sends.    The number of lines of information kept in the log files is settable.    Each night the 
logs are trimmed to keep them at this length (old log entries are removed).



Reports

PageGate has several useful reports to help you manage the application.    Log files containing PageGate's activity 
are found in the reports section.    A report showing the entire user database is available.    There is a carrier database
report.    A report that shows the number of messages sent to each user within a certain number of days, is also 
available.



Front-end Interfaces

PageGate has several front-end interfaces, which allows it to accept messages from many sources.    Each interface 
can be used alone, or in conjunction with the other interfaces.    Some of the interfaces gain added capabilities when 
used with each other.    For example, if the email gateway interface is used at the same time as the web interface, a 
copy of each message received via a web page can be forwarded to the recipient's email account (this gives the 
recipient a record of messages received in his/her email mailbox).    Currently supported front-end interfaces are: 
Windows GUI client (NotePager Net), Commandline/Ascii Interface, Email Gateway, WWW Gateway, and TTY/TDD 
Gateway.



Modularity/Scalability

PageGate has a very modular design that allows for its high scalability.    On busy systems up to 4 intelligent dialers, 
each controlling it's own modem, can be used.    Each of PageGate's modules can be run on a separate computer (or 
all on a single computer).    With all of PageGate's modules in use, the PageGate application could actually be spread
across 10 machines (not counting a possible two more to run a web server and a mail server).    This architecture 
enables PageGate to handle a very large volume of messages per hour.



Download File Installation Instructions:

If you have downloaded NotePager Net in a single file (npnetv2.exe or npnetv2.zip), use these instructions.    If you 
have a NotePager Net CD-Rom, see 'CD-Rom Installation Instructions'.

If you have downloaded the executable install file (npnetv2.exe), skip to
step #4.

If you have downloaded the zipped install file (npnetv2.zip), start with
step #1.

1)    Copy the downloaded file (npnetv2.zip) to a temporary directory (i.e. c:\temp or c:\windows\temp)

2)    Use an unzip utility such as WinZip or PKunzip to decompress the file.

3)    The executable installation program will be extracted (npnetv2.exe)

4)    Execute (run) the NotePager Net installation program (npnetv2.exe)

5)    You will be presented with the 'WinZip Self-Extractor [NPNETV.EXE]' window.    Click on the 'Setup' button.    
Some temporary files will be decompressed.

6)    NotePager Net's installation 'Welcome' screen will be displayed. Click the 'OK' button to continue.

7)    The application installation choice screen will be displayed. Choose 'Server Install' to install PageGate 
(NotePager Net's paging server application).    Or, choose 'Workstation Install' to install the NotePager Net client 
program on this workstation.

8)    The next screen will allow you to change the default installation directory by clicking on the 'Change Directory' 
button.    When you are satisfied with the installation directory, click on the large button with the installation graphic
on it.    This will copy the program files to your computer and make all necessary system changes to run 
NotePager Net.

9)    The setup completion screen will appear, indicating a successful install.    Click on the 'OK' button to exit the 
installation program.

10) NotePager Net's workstation or server installation is now complete.    Please note that the PageGate server 
application must be installed, setup, and running before the NotePager Net client application can be used.



CD-ROM Installation Instructions:

If you have a NotePager Net CD-Rom, use these instructions.    If you have downloaded NotePager Net in a single file
(npnetv2.exe or npnetv2.zip), see 'Download File Installation Instructions'.

1)    On most systems, the installation program will automatically start after the Cd-Rom is inserted into the drive.    If 
the installation program doesn't start, run the setup.exe program on the CD-Rom.

2)    NotePager Net's installation 'Welcome' screen will be displayed. Click the 'OK' button to continue.

3)    The application installation choice screen will be displayed. Choose 'Server Install' to install PageGate 
(NotePager Net's paging server application).    Or, choose 'Workstation Install' to install the NotePager Net client 
program on this workstation.

4)    The next screen will allow you to change the default installation directory by clicking on the 'Change Directory' 
button.    When you are satisfied with the installation directory, click on the large button with the installation graphic
on it.    This will copy the program files to your computer and make all necessary system changes to run 
NotePager Net.

5)    The setup completion screen will appear, indicating a successful install.    Click on the 'OK' button to exit the 
installation program.

6)    NotePager Net's workstation or server installation is now complete.    Please note that the PageGate server 
application must be installed, setup, and running before the NotePager Net client application can be used.



General

Group paging - messages can be sent to a predefined group of users

Multiple recipients - allows a single message to be sent to more than one user and/or group 

Intelligent message queuing - messages for the same carrier are grouped together and sent during a single 
communications session

Dialup or direct connect - PageGate can be connected to a paging terminal by a direct cable connection, or through a
modem.

Message splitting - Long messages are intelligently split into multiple smaller messages

Settable character limits - The maximum number of characters to be sent in a message is settable by carrier and 
individual user

On-call groups - A schedule can be setup for the users in a group, allowing PageGate to send messages to only the 
users scheduled to receive messages a that point in time.

TAP/IXO/PET compliant - supports any messaging device that follows one of these standards.    This includes 
cellular/pcs/digital phones, PIMS, alphanumeric and numeric pagers, PC/PCMCIA cards, bill boards, etc.

Touch-tone message support - supports paging service providers that only accept touch-tone messages for numeric 
pagers

Message logging - PageGate's general log keeps a history of all messages sent.    Each dialer can also keep a 
detailed log of the communication sessions with the paging carriers.

Modular / Scaleable - PageGate's modular architecture allows the application to be run across several computers for 
high throughput applications.

Reliapage - provides a way for users to be aware that a message has been missed.

Requeue messages - missed messages can be requeued for re-transmission to the paging carrier

High throughput /volume - PageGate's intelligent queuing of messages and multiple dialers allows for a large volume 
of messages per hour.



GUI Client (NotePager Net)

Local and network user lists - on each workstation you can choose recipients from the network user list, or from a 
smaller personal user list which can be defined for each workstation

Scheduled messages - messages can be scheduled to be sent at a future date/time

Repeating messages - messages can be scheduled to repeat at a predefined interval

Pre-programmed messages - on each workstation, up to five pre-programmed messages can be defined

Real-time message status log - each workstation can track the progress of each message from start to finish

Real-time message status counters - displays current number of messages pending, sent, or failed from each 
workstation

Message character counter - displays the length of the current message

Message history log - displays a history of all messages sent from each workstation

Point and click operation - an intuitive user interface makes NotePager Net very easy to use 

Spell check - a spell check option is available on systems running MS Word 

User cueing -Users may be selected by typing the first few letters of their name

Restricted user lists - NotePager Net users can be restricted to only be able to use a local user list



Commandline/Ascii

DOS Commandline – messages can be sent from a DOS prompt

Windows Commandline – messages can be sent from a Windows commandline

Polling – a directory can be polled for Ascii text files containing message information

Ad-Hoc recipients – messages can be sent by using PIN numbers (users don't need to be setup inside PageGate).    
Only available with 5000 user license or greater

Multi-Page recipients – multiple recipients can be specified within a single message

Message Tracking – messages sent via this interface can be tracked via status directories

3rd party application support – messages can be sent from any application that can issue a commandline command 
(shell command) or create an Ascii text file.

Custom Application Support – this is a popular interface for developers who want an easy way to add paging to their 
application.



Email Gateway

Forwarding – each user can have their messages forwarded to an additional email account

Ad-Hoc recipients – messages can be sent by using PIN numbers (users don't need to be setup inside PageGate).    
Only available with 5000 user license or greater

Multi-Page recipients – multiple recipients can be specified within a single email message

Automatic Account Creation – user accounts created within PageGate will automatically create an account on the 
mail server.

Email Outcome – the success or failure of messages sent can be automatically returned via email

Numeric Email Notification – numeric pagers can receive notification of the arrival of email messages

Full Module Integration – integrates with all other PageGate modules for forwarding of messages received via email



Web Gateway

Automatic Web Page Generation – web pages can be created automatically by using template files

Web Page Templates – custom web page templates can be created for use when web pages are created 
automatically for new users

Custom Web Page Support – messages can be sent from within custom web pages

Flexible Web Server Support – PageGate can be used with any windows based web server

Ad-Hoc recipients – messages can be sent by using PIN numbers (users don't need to be setup inside PageGate).    
Only available with 5000 user license or greater

Multi-Page recipients – multiple recipients can be specified within a single message

Drop-Down List Support – web pages with drop down lists of users is supported, and automatically updates

User Verification – users are notified immediately if a message is sent to an invalid username



System Limits

Number of paging devices supported: 32,000 (unlimited if ad-hoc feature is used).    Note: PageGate is licensed by 
number of users (pagers).    Smaller licenses support a smaller number of users (pagers).

Number of simultaneous dialers (modems): 4 (more available upon request)

Number of direct cable connections: 1 (counts as a dialer)

Message length: unlimited (messages longer than 240 characters are broken into multiple messages)

Number of carriers: 32,000

Number of groups: 32,000

Number of users in a group: 32,000

Number of NotePager Net client workstations: 32,000
        



Overview

PageGate's GUI module is a windows based client application named NotePager Net.    It is designed to run on the 
same Local Area Network (LAN) as the PageGate server.    NotePager Net has many advanced features such as: 
personal user lists, personal pre-programmed messages, scheduled messages, repeating messages, and spell 
checking.    NotePager Net is easy to install and has a very intuitive user interface.    With NotePager Net, messages 
can be sent from any workstation on the LAN.    The PageGate server queues up the messages and sends them with 
its modem(s).    The workstations receive real-time status information on the messages they have sent.    The 
NotePager Net module has no visible window on the PageGate server screen.



Starting

NotePager Net can be started with the 'NotePager Net' icon in the Start menu.    Alternately, the NPNet.exe program 
can be manually run to start the client interface.



Overview

The GetAscii module enables PageGate to accept messages from many off-the-shelf, third-party, and custom 
applications.    It is responsible for accepting messages sent via the sendpage.exe commandline program, and for 
polling a predetermined directory for Ascii text files containing message information.    This interface is very popular in 
several different types of applications.    Many third-party programs have the ability to issue a DOS/Windows 
commandline command (shell command).    The GetAscii interface will enable these programs to send messages to 
PageGate by using the sendpage command.    Many developers find that using the GetAscii interface and easily add 
paging capabilities to their applications.    The GetAscii interface can even be used to accept messages from other 
operating systems.    With an FTP application running, message files can be transferred into the directory being polled
by GetAscii.    This would enable MAC's Unix systems, mini computers, etc. to send messages with PageGate.
The 'Status' field on GetAscii's windows shows whether it is 'Running' or 'Stopped'.    The 'Last Message From' field 
displays who the last message processed was sent from.    The 'Last Message To' field displays who the last message
was sent to.    The 'Last Filename' field displays the file name given to the last message that was processed.    The 
'Good' and 'Bad' fields show how many messages were successfully or unsuccessfully processed.



Starting

PageGate's GetAscii interface is automatically started if the pagegate.exe, pgstart.exe, or pgstartm.exe programs are
used to start PageGate.    Pagegate.exe is the default startup program in the Windows Start menu.    GetAscii can be 
manually started by running the getascii.exe program.



Running on a separate computer

GetAscii can be installed and run on a separate machine than the rest of the PageGate paging server application.    
To do this, install PageGate on the remote system following the regular installation instructions.    After the installation 
is finished, manually run the pgadmin.exe program from the PageGate program directory.    When the Admin program 
is run for the first time, it will prompt you for a path to the PageGate database.    Enter the path (or browse using the ...
button) to the existing PageGate database on the PageGate server computer.    Quit out of the PageGate programs. 
GetAscii (getascii.exe) can now be run on this machine.    You may want to create an icon to make it easier to start in 
the future.



Using sendpage.exe to Send Messages

The sendpage commandline program can be used to send messages to PageGate.    It can be run from a DOS or 
Windows commandline, or from within any program that can issue a commandline (shell) command.    Sendpage 
must be told where to create its temporary message files.    This location must be the same as the Polling Directory, 
which is set in PageGate's Admin program.    The person or application that runs sendpage.exe must have sufficient 
rights to create files in this directory.    The syntax of sendpage.exe is a s follows (typing sendpage.exe /? will also 
give this information):

sendpage [-dir=dest] to from message

'sendpage' is the name of the program itself

-dir= is a commandline option that sets the directory to where the temporary message files will be stored. 

'dest' should be replaced with the actual path to the GetAscii Polled directory 

'to' should be replaced with the username of who the message is to (can not be blank)

'from' should be replaced with who the message is being sent from (can not be blank)

'message' should be replaced with the actual message text (can not be blank)

Example:    sendpage -dir=c:\pages Chris Peter This is a test message

Optionally a DOS environment variable can be set so that the [-dir=dest] option does not need to be included in the 
command.    The environment variable name is SNDPGDIR.

Example:    SET SNDPGDIR=C:\PAGES

Here is an example message with the SNDPGDIR environment variable set:

Example:    sendpage Chris Peter This is a test message



Using Ascii Text Files to Send Messages

The GetAscii front-end interface can used to poll a directory for Ascii text files that contain messages.    An Ascii text 
file is simply a file containing text only.    The DOS EDIT and Window NotePad programs create Ascii text files by 
default.    Ascii text files can also be created from within virtually any programming environment.    In order for GetAscii
to pick-up Ascii text file messages, the file must be put in the Polled Directory specified in PageGate's Admin 
program.    Also GetAscii will only look for files with the .asc extension.    If more than one file with a .asc 
extension exists in the polled directory, the files are sorted alphabetically and then processed in alphabetical order.    
The format of the .asc files is as follows:

to
from
message

Please note that each line must have a carriage return terminating it (or carriage return and line feed).

'to' should be replaced with the username of who the message is to (can not be blank)

'from' should be replaced with who the message is being sent from (can not be blank)

'message' should be replaced with the actual message text.    The 'message' area is actually everything after the 
'from' line.    Therefore multiple lines of message data is valid. (can not be blank)

Example file named test.asc:

Chris
Peter
This is a
test.



Advanced Options

Multi-Page
A single text file can be used to send a single message to more than one recipient, by using PageGate's Multi-Page 
option.    In PageGate's Admin program, create a user and set it as a Multi-Page User.    This username is simply used
as a flag to say that more usernames follow.    For example, if a user named 'mpu' is setup as a Multi-Page user, this 
would be an example of a message being sent to more than one user:

mpu Chris Bob Mary Steve
Peter
This is a test sent to four people

The above example would send the same message to Chris, Bob, Mary, and Steve.    Multiple names on the 'to' line 
should divided by spaces, commas, or semi-colons.

Ad-Hoc
Ascii text files can also be used to send messages to pagers by using their PIN (ID) numbers.    This option is only 
available with the 5000 user license or greater.    The advantage of this feature is that a user account for each pager 
would not have to be setup in PageGate.    Only a single Ad-Hoc user would need to be setup for each carrier.    The 
disadvantage is that the sender must know the PIN (ID) numbers of the pagers (sometimes harder to remember than 
user names).    Sending messages using Ad-Hoc is similar to sending Multi-Page messages.    In PageGate's Admin 
program, create a user and set it as an Ad-Hoc user.    The carrier information must be correct; it is used to set which 
carrier the messages are sent to.    If    'ahu' were an Ad-Hoc user, this would be a sample text file to send Ad-Hoc 
messages:

ahu 1234567 7654321 2468086
Peter
This is a test Ad-Hoc message

The above example would dial the carrier specified by the ahu account and send the message to the pagers with PIN
(ID) numbers 1234567, 7654321 and 2468086.    Multiple PIN (ID) numbers on the 'to' line should be separated by 
spaces, commas, or semi-colons.



More GetAscii Information

The Ascii/Commandline engine will check the directory you setup in the Admin program for files that have .asc as an 
extension.    It will check for the files at the polling interval (in seconds) which is also setup in the Admin program.    
When the directory is polled, and a file is found, it is immediately moved to the process subdirectory (underneath the 
polled directory) and given a unique filename (the .asc is replaced with a unique number).    If in the same polling 
period, two or more files are put into the polled directory with the same filename the first file will be overwritten by the 
second.    The files are not given a unique name until the directory is actually polled.    To avoid this, if the files are 
being written by an application, be sure to use unique filenames.    If the sendpage program is being used, unique 
filenames are automatically generated.    When the message is polled, if the format of the message or the user name 
is invalid, it will be immediately moved to the 'bad' subdirectory (under the polled directory).    The file will have the 
same filename it was originally given, but the extension will be changed to a unique number.    If the message is in a 
valid format and the user is also valid, the message will be moved to the 'process' subdirectory (under the polled 
directory) and then given to the paging engine for delivery.    When the paging engine is done with the message, it will
be moved from the 'process' subdirectory to either the 'good' or the 'bad' subdirectory depending on the ability of the 
engine to send the message to the carrier.    Application programs can check the 'process', 'good' and 'bad' 
subdirectories for the original filename (with .* as an extension), to verify the status of the message.    Messages are 
purged from the 'good' and 'bad' directories when they are older (in days) than the 'purge after' setting in the Admin 
program's setup window.



Overview

The GetMail module enables PageGate to act as an email to pager gateway.    Using PageGate, information in email 
messages can be sent to user's pagers.    GetMail is responsible for retrieving email messages from the MDaemon* 
mail server.    The from field, subject field, and message body are extracted from the email messages.    Attachments 
such as graphics etc. are ignored.    A copy of messages sent to each user's pager can be optionally forwarded to an 
additional email address for that user.    This way the user can have a 'hard copy' of all messages sent to his/her 
pager, in their regular email mailbox.    This forwarding option is also very useful when used with the other front-end 
interfaces.    For example, if a message is sent to a user via GetAscii, Get Web or NotePager Net, a copy of the 
message can be forwarded to the user's email mailbox.    When new account are added into PageGate, PageGate 
automatically creates an email account for that user on the mail server.    Account maintenance for the email users is 
automatic: no maintenance is necessary at the mail server.
The 'Status' field on GetMail's window shows whether it is 'Running' or 'Stopped'.    The 'Last Message From' field 
displays who the last message was from.    The 'Last Message To' field displays who the last message was sent to.    
The 'Good' and 'Bad' fields show how many messages were successfully and unsuccessfully processed.



Starting

PageGate's GetMail interface is automatically started if the pagegate.exe, pgstart.exe, or pgstartm.exe programs are 
used to start PageGate.    Pagegate.exe is the default startup program in the Windows Start menu.    GetMail can be 
manually started by running the getmail.exe program.



Running on a separate computer

GetMail can be installed and run on a separate machine than the rest of the PageGate paging server application.    To
do this, install PageGate on the remote system following the regular installation instructions.    After the installation is 
finished, manually run the pgadmin.exe program from the PageGate program directory.    When the Admin program is 
run for the first time, it will prompt you for a path to the PageGate database.    Enter the path (or browse using the ... 
button) to the existing PageGate database on the PageGate server computer.    Quit out of the PageGate programs. 
GetMail (getmail.exe) can now be run on this machine.    You may want to create an icon to make it easier to start in 
the future.

*    The MDaemon mail server must be installed, configured, and running in order for GetMail to work.    It can be used 
as the sole mail server, or in conjunction with and existing mail server.    A shareware version of MDaemon is included
with PageGate for your evaluation (md26oem4.exe).    Information, tech support, and pricing for MDaemon are 
available at www.mdaemon.com.    MDaemon is not a NotePage, Inc. product.    



Advanced Options

Multi-Page
A single email message can send its contents to many PageGate users by using the Multi-Page feature.    A Multi-
Page user must first be setup in PageGate's Admin program.    It is simply used as a flag, the user information is not 
important.    To send a Multi-Page message, address the email to the Multi-Page user, and then specify all the users 
the message should be sent to in the subject line of the email message.    User names in the subject line should be 
separated by spaces, commas, or semi-colons.    If some users are to be used exclusively with the Multi-Page option, 
you may not want them to actually have a mailbox on the mail server.    See 'Maintain Mailbox' below.

Ad-Hoc
Email messages can be used to send messages to pagers by using their PIN (ID) numbers.    This option is only 
available with the 5000 user license or greater.    The advantage of this feature is that a user account for each pager 
would not have to be setup in PageGate.    Only a single Ad-Hoc user would need to be setup for each carrier.    The 
disadvantage is that the sender must know the PIN (ID) numbers of the pagers (sometimes harder to remember than 
user names).    Sending messages using Ad-Hoc is similar to sending Multi-Page messages.    In PageGate's Admin 
program, create a user and set it as an Ad-Hoc user.    The carrier information must be correct; it is used to set which 
carrier the messages are sent to. To send an Ad-Hoc email message, address the email to the Ad-Hoc user, and then
specify all the PIN (ID) numbers the message should be sent to in the subject line of the email message.    PIN (ID) 
numbers in the subject line should be separated by spaces, commas, or semi-colons.

Maintain Mailbox
By default, for all users that have the email service enabled, a mailbox is created on the mail server.    If any users are
setup with the intention of only being used with the Multi-Page feature, there is no need for those users to have a 
mailbox on the mail server. On the user setup screen, this box can be un-checked so that no mailbox will be 
maintained for that user.

Email Outcome
When email is used to send messages to PageGate, the sender has no way of knowing if the message was actually 
received, accepted as valid, or sent to the paging terminal.    When the Email Outcome option is checked, an email 
message will be sent back to the sender if there is a problem with the message or when the message is successfully 
sent to the paging terminal.

Remove Sender's Domain
When email messages are sent to PageGate, the sender's email address is used as the 'from' field, and sent with the
message to the paging terminal and ultimately to the user's pager.    Some pagers do not hold or display a lot of 
characters, and also some email addresses can be very long.    If you want the domain portion of the sender's 
address (the part after the @) stripped off, check this box in the user's setup screen.



More GetMail Information

PageGate automatically maintains mail accounts on the MDaemon mail server for its users (if the GetMail service is 
enabled for the user).    The email address in the mail server is the same as the username in PageGate.    When 
forwarding information is changed, or users are deleted within PageGate, the changes are made automatically in the 
mail server too.    The MDaemon mail server can be run as the sole mail server or in conjunction with an existing mail 
server.    Many PageGate users are using MDaemon for their paging installation only.    They simply setup the user 
accounts on their existing mail server to forward a copy of each user's email messages to the user's account on the 
'Paging' (MDaemon) mail server.    



Overview

The GetWeb module enables PageGate to take messages that have been entered in a form on a web page, and sent
them to a pager.    It is responsible for retrieving these messages from a web server.    A CGI program (webgate.exe) 
is included with GetWeb to be used with the web server.    Webgate is a Windows CGI program and therefore can 
only be used with Windows based web servers.    When user accounts are added into PageGate, personal web 
pages, for the users, can be automatically created from a web page template (some example templates are 
included).    Optionally, custom designed web pages can be used for each user.    Groups defined within PageGate 
can also have web pages automatically created for them.    Other web page options are: A generic web page that can 
be used to send a message to any user by entering their username.    An Ad-Hoc web page where a pager's PIN (ID) 
number can be entered to send a message.    And, a drop-down list web page where the sender can choose one or 
more names from a list of users.    Web pages can even be hosted on any number of remote servers, and still use the
webgate CGI program on the local server to send messages to PageGate.
The 'Status' field on GetWeb's window shows whether it is 'Running' or 'Stopped'.    The 'Last Message From' field 
displays who the last message was from.    The 'Last Message To' field displays who the last message was sent to.    
The 'Good' and 'Bad' fields show how many messages were successfully and unsuccessfully processed.



Starting

PageGate's GetWeb interface is automatically started if the pagegate.exe, pgstart.exe, or pgstartm.exe programs are 
used to start PageGate.    Pagegate.exe is the default startup program in the Windows Start menu.    GetWeb can be 
manually started by running the getweb.exe program.



Running on a separate computer

GetWeb can be installed and run on a separate machine than the rest of the PageGate paging server application.    
To do this, install PageGate on the remote system following the regular installation instructions.    After the installation 
is finished, manually run the pgadmin.exe program from the PageGate program directory.    When the Admin program 
is run for the first time, it will prompt you for a path to the PageGate database.    Enter the path (or browse using the ...
button) to the existing PageGate database on the PageGate server computer.    Quit out of the PageGate programs. 
GetWeb (getweb.exe) can now be run on this machine.    You may want to create an icon to make it easier to start in 
the future.



Using the webgate.exe CGI Program

When a person fills out a form on a web page and presses the submit button, a program is run by the web server and
given the information that was typed into the form.    One kind of program that can be run by the web server is called a
CGI.    The webgate.exe CGI program is included with the GetWeb interface for this purpose.    Webgate must be put 
on the web server in a directory where the server looks for CGI programs.    This is usually the cgi-bin or scripts 
directory.    When you specify the CGI Data Path in PageGate's Admin program, the webgate.exe program is copied 
to that location.    The webgate.exe CGI can be named as the form action in any web page to enable the form's data 
to be sent to it.    Here is a simple web page example that uses webgate.exe:

<HTML>
<HEAD>
<TITLE>
Sample Pager Web Page
</TITLE>
</HEAD>
<BODY>
<H2><CENTER>Enter a message to be sent to a pager</CENTER></H2>
<HR>
<FORM ACTION ="http://www.mydomain.com/cgi-bin/webgate.exe" METHOD=POST>
<CENTER>FROM</CENTER>
<CENTER>
<INPUT SIZE=40 MAXLENGTH=100 NAME="FRM"></TEXTAREA>
</CENTER>
<BR>
<CENTER>MESSAGE</CENTER>
<CENTER>
<TEXTAREA COLS=60 ROWS=5 WRAP=VIRTUAL NAME="MSG"></TEXTAREA>
</CENTER>
<BR>
<CENTER>
<INPUT TYPE=SUBMIT NAME = "SEND" VALUE = "SEND PAGE">
<INPUT TYPE=RESET VALUE = "CLEAR FORM">
</CENTER>
<INPUT TYPE=HIDDEN NAME="USER" VALUE="pageruser"> 
</FORM>
</BODY>
</HTML>

In this example, please notice the path used for the webgate.exe CGI program.    In web pages the path should be set
to the full URL of the CGI program as seen from the WWW.    You would substitute your domain name for 
'mydomain.com'.    The user name of the pager in this example is 'pageruser'.    Every web page that is to use 
webgate must have the following variables included in them.    They can be either set by the user of the form, or hard 
coded into the form:

FORM ACTION - naming webgate.exe as the form's action
FRM - a text field that will contain the name of who the message is being sent from
MSG - a text field that will contain the actual message text
USER - a text field that will contain the name of the user (pager) the message is to be sent to

Here are some optional fields that can be used:

NOPAGE - if this field is set to 'NOPAGE', the message won't actually be sent to the user's pager.    It will however be 
forwarded to the user's email forwarding address (if GetMail is setup).    This would turn the web page into a sort of 
web to email gateway.
SUBJECT - to use the Multi-Page option, a SUBJECT field is used for the user names.

This is an example where the pager's username is not hard-coded into the web page, and can be typed manually 
each time (also the NOPAGE option is given):

<HTML>
<HEAD>



<TITLE>
PageGate's Page-A-User Web Page
</TITLE>
</HEAD>
<BODY>
<H2><CENTER>Fill in This Form to Send a Page</CENTER></H2>
<FORM ACTION ="http://www.mydomain.com/cgi-bin/webgate.exe" METHOD=POST>
<CENTER>
USER <INPUT SIZE=40 MAXLENGTH=40 NAME="USER"></TEXTAREA>
</CENTER> 
<BR>
<CENTER>
FROM <INPUT SIZE=40 MAXLENGTH=80 NAME="FRM"></TEXTAREA>
</CENTER>
<BR>
<CENTER>MESSAGE</CENTER>
<CENTER>
<TEXTAREA COLS=60 ROWS=5 WRAP=VIRTUAL NAME="MSG"></TEXTAREA>
</CENTER>
<BR>
<CENTER>
<INPUT TYPE=SUBMIT NAME = "SEND" VALUE = "SEND PAGE"><INPUT TYPE=RESET VALUE = "CLEAR 
FORM">
</CENTER>
</FORM>
</BODY>
</HTML>

Multi-Page
A message can be sent to many PageGate users (pagers) by using the Multi-Page feature.    A Multi-Page user must 
first be setup in PageGate's Admin program.    It is simply used as a flag, the user information is not important. With 
the Multi-Page user set as the web page's USER field, the SUBJECT field is used to receive the actual user names.    
The user names can be separated by spaces, commas, or semi-colons:

<HTML>
<HEAD>
<TITLE>
PageGate's Multi-Page Web Page
</TITLE>
</HEAD>
<BODY>
<H2><CENTER>
Fill in This Form to Send a Page.
More than one username can be input
</CENTER></H2>
<FORM ACTION ="http://www.mydomain.com/cgi-bin/webgate.exe" METHOD=POST>
<INPUT TYPE=HIDDEN NAME="USER" VALUE = "put multi-page username here"> 
<CENTER>
TO <INPUT SIZE=60 MAXLEN=200 NAME="SUBJECT"></TEXTAREA>
</CENTER>
<BR>
<CENTER>
FROM <INPUT SIZE=40 MAXLENGTH=80 NAME="FRM"></TEXTAREA>
</CENTER>
<BR>
<CENTER>MESSAGE</CENTER>
<CENTER>
<TEXTAREA COLS=60 ROWS=5 WRAP=VIRTUAL NAME="MSG"></TEXTAREA>
</CENTER>
<BR><BR>
<CENTER>
<INPUT TYPE=CHECKBOX NAME="NOPAGE" VALUE = "NOPAGE">Send Email Only (do not send page)



</CENTER>
<BR>
<CENTER>
<INPUT TYPE=SUBMIT NAME = "SEND" VALUE = "SEND PAGE"><INPUT TYPE=RESET VALUE = "CLEAR 
FORM">
</CENTER>
</FORM>
</BODY>
</HTML>

Ad-Hoc
Messages can be sent to pagers by using their PIN (ID) numbers.    This option is only available with the 5000 user 
license or greater.    The advantage of this feature is that a user account for each pager would not have to be setup in 
PageGate.    Only a single Ad-Hoc user would need to be setup for each carrier.    The disadvantage is that the sender
must know the PIN (ID) numbers of the pagers (sometimes harder to remember than user names).    Sending 
messages using Ad-Hoc is similar to sending Multi-Page messages.    In PageGate's Admin program, create a user 
and set it as an Ad-Hoc user.    The carrier information must be correct; it is used to set which carrier the messages 
are sent to. With the Ad-Hoc user set as the web page's USER field, the SUBJECT field is used to receive the PIN 
(ID) numbers.    The PIN (ID) numbers can be separated by spaces, commas, or semi-colons:

<HTML>
<HEAD>
<TITLE>
PageGate's Ad-Hoc Web Page
</TITLE>
</HEAD>
<BODY>
<H2><CENTER>
Fill in This Form to Send a Page
</CENTER></H2>
<FORM ACTION ="http://www.mydomain.com/cgi-bin/webgate.exe" METHOD=POST>
<INPUT TYPE=HIDDEN NAME="USER" VALUE = "put ad-hoc user name here"> 
<CENTER>
TO <INPUT SIZE=60 MAXLEN=200 NAME="SUBJECT"></TEXTAREA>
</CENTER>
<BR>
<CENTER>
FROM <INPUT SIZE=40 MAXLENGTH=80 NAME="FRM"></TEXTAREA>
</CENTER>
<BR>
<CENTER>MESSAGE</CENTER>
<CENTER>
<TEXTAREA COLS=60 ROWS=5 WRAP=VIRTUAL NAME="MSG"></TEXTAREA>
</CENTER>
<BR><BR>
<CENTER><INPUT TYPE=SUBMIT NAME = "SEND" VALUE = "SEND PAGE"><INPUT TYPE=RESET VALUE = 
"CLEAR FORM"></CENTER>
</FORM>
</BODY>
</HTML>

Template Files
A custom web page could be written for each user, however this approach may be overwhelming for a large-scale 
installation.    PageGate allows you to create web page template files that are used to automatically create web pages
for its users.    When you are creating a new user, or editing an existing user in PageGate's Admin program, you can 
hit the 'Web Page' button to create or edit the web page for the current user (GetWeb must be enabled for this button 
to be active).    First, you must choose a template file from the drop-down list (template files belong in the 'templates' 
directory beneath the 'Web Pages Path' directory).    After a template is chosen, enter the text messages to be 
inserted into the template file.    Below is an example template file that would be used to create a web page similar to 
the first example above (this template is shipped with PageGate and named basic.htm).

<HTML>



<HEAD>
<TITLE>
~~~text1~~~
</TITLE>
</HEAD>
<BODY>
<H2><CENTER>~~~text2~~~</CENTER></H2>
<HR>
<FORM ACTION ="http://www.mydomain.com/cgi-bin/webgate.exe" METHOD=POST>
<CENTER>FROM</CENTER>
<CENTER>
<INPUT SIZE=40 MAXLENGTH=100 NAME="FRM"></TEXTAREA>
</CENTER>
<BR>
<CENTER>MESSAGE</CENTER>
<CENTER>
<TEXTAREA COLS=60 ROWS=5 WRAP=VIRTUAL NAME="MSG"></TEXTAREA>
</CENTER>
<BR>
<CENTER>
<INPUT TYPE=SUBMIT NAME = "SEND" VALUE = "SEND PAGE">
<INPUT TYPE=RESET VALUE = "CLEAR FORM">
</CENTER>
<INPUT TYPE=HIDDEN NAME="USER" VALUE="~~~user~~~"> 
</FORM>
</BODY>
</HTML>

PageGate uses text substitution with the template files to insert message text and user names into the template files 
(notice ~~~text1~~~, ~~~text2~~~, and ~~~user~~~ in the above example).    If you chose this template while setting 
up a new user in PageGate, you would set the Text1 field on the user's web page setup screen to 'Sample Pager 
Web Page', and the Text2 field to 'Enter a message to be sent to a pager'.    The ~~~user~~~ field will automatically 
replaced with the username.    Up to ten text variables (~~~text1~~~ thru ~~~text10~~~) can be used in the template 
files for automatic substitution.    In addition, up to five image variables(~~~image1~~~ thru ~~~image5~~~) can be 
used to substitute image file names into the template (these files must exist in the \images directory beneath the 'Web
Pages Path' directory).

When PageGate creates a web page for a user, it creates a directory under the 'Web Pages Path' directory that is 
specified on the GetWeb tab of PageGate setup screen.    The directory is named the same as the PageGate user's 
name.    The web page is named default.htm (and copied to index.htm) and placed into the newly created directory.    
This structure allows for easy addressing of user web pages.    For example if the 'Web Pages Path' was set to the 
root directory of the web server at 'mydomain.com', and a user was created with the name 'chris', you could get Chris'
web page by going to www.mydomain.com/chris.    If the root directory of the web server were c:\webserver\wwwroot, 
Chris' web page file would be c:\webserver\wwwroot\chris\default.htm (or index.htm).

Custom Web Pages
Custom web pages can be used with PageGate instead of pages created from templates.    Simply check off the 
'Custom Page' option on the user's web page setup screen to tell PageGate not to create web pages for that user.

Group List Web Pages
Group list web pages enable PageGate to maintain web pages that have a drop-down list of user names on them.    
These pages allow www users to choose one or more names from a drop-down list to send a message to.    When 
users belonging to groups that have drop-down lists change, the drop-down list web pages are automatically 
updated.    To enable Group List web pages, you must first have a group setup in PageGate with users in it.    Create a
web page for the group by pressing the 'Web Page' button on the group's setup screen.    Choose a Group List 
template file to be used (an example called list.htm is included).    Fill in any needed text or image fields and check the
'Group List' option box.    A Group List web page will be created for that group.    When a message is entered from the 
www into the Group List web page, only the users selected from the list will be sent the message, not the entire group
(unlike any other group web page).    Below is an example of a Group List web page:



<HTML>
<HEAD>
<TITLE>
~~~text1~~~
</TITLE>
</HEAD>
<BODY>
<H2><CENTER>~~~text2~~~</CENTER></H2>
<HR>
<FORM ACTION ="http://www.mydomain.com/cgi-bin/webgate.exe" METHOD=POST>
<INPUT TYPE=HIDDEN NAME="USER" VALUE = "~~~user~~~">
<CENTER>
<SELECT NAME="SUBJECT" SIZE=5 MULTIPLE>
~~~list~~~
</SELECT>
</CENTER>
<BR>
<CENTER>
FROM
</CENTER>
<CENTER>
<INPUT SIZE=40 MAXLENGTH=100 NAME="FRM"></TEXTAREA>
</CENTER>
<BR>
<CENTER>MESSAGE</CENTER>
<CENTER>
<TEXTAREA COLS=60 ROWS=5 WRAP=VIRTUAL NAME="MSG"></TEXTAREA>
</CENTER>
<BR><BR>
<CENTER>
<INPUT TYPE=CHECKBOX NAME="NOPAGE" VALUE = "NOPAGE">Send Email Only (do not send page)
</CENTER>
<BR>
<CENTER>
<INPUT TYPE=SUBMIT NAME = "SEND" VALUE = "SEND PAGE"><INPUT TYPE=RESET VALUE = "CLEAR 
FORM">
</CENTER>
</FORM>
</BODY>
</HTML>



Advanced Options

Returning to a Specific Webpage

When the user submits a message to PageGate, they are given a response webpage indicating the success or failure
of their request.    In either case, on the response webpage an option 'Back to Message Form' is given.    This 
normally returns the user to the webpage form.    By setting the variable BACK_REF in the webpage, you can specify 
another webpage to return to rather than the form just used.

Example: (this text would be included in the web page) 

<INPUT TYPE=HIDDEN NAME="BACK_REF" VALUE="http://www.mydomain.com/UseThisPage">

Using Your Own Successful Response Webpage

When a user submits a valid message to PageGate, they are given a response webpage indicating the acceptance of
the messages.    You can use your own webpage to indicate the message was accepted.    You can create a standard 
html webpage named webgate.rsp and put it into the same directory as the webgate.exe CGI program.    If it exists, 
this webpage will be used instead of the standard response page.    If you want to make this file different for each 
user, it can be saved in the same directory as the user's webpage (if it exists in the user's webpage directory, it will be
used before the one in the CGI directory)



More GetWeb Information

Some knowledge of writing web pages is required to write template files (or any other web page for that matter).    The
example web page files and templates (anyuser.htm, ad-hoc.htm, basic.htm, list.htm, and multipage.htm) should be 
used and studies before making you own.    When a web page form is submitted, the webgate CGI program checks 
for the existence of all required fields, and checks the user names against a list of valid PageGate users.    If any of 
these check fail, the www user is given an error message screen telling them what they did wrong.    The www user 
can then backup, fix the problem, and resubmit the form.    If the form data is accepted, the www user is given a 
screen stating that the message has been successfully accepted for processing.





General

PageGate Program Directory
This is where the PageGate application files reside.    The default location for this directory is:    \Program Files\
PageGate.

PageGate Database Directory
This is where PageGate's main database file is located.    All of PageGate's modules must have full access to this 
directory.    The default location for this directory is:    \Program Files\PageGate.

Bad Message Directory
This is where messages that are unable to be processed by PageGate reside.    The default location for this directory 
is:    \Program Files\PageGate\badmsg.



Email Gateway

MDaemon Program Directory
In order to use PageGate's email front-end interface, the MDaemon mail server must be installed, configured, and 
running.    the default install directory for MDaemon is \MDAEMON.    PageGate uses three sub-directories beneath 
the MDaemon root directory (\MDAEMON). These directories are \MDAEMON\APP, \MDAEMON\USERS, and \
MDAEMON\RAWFILES.    During the setup of the GetMail interface, you are asked for two separate paths to the mail 
server: A 'local' path and a 'network' path.    The 'local' path is the path to the mail server from the point of view of the 
mail server itself (i.e. c:\mdaemon).    The 'network' path is the path to the mail server as seen by the rest of the 
network (i.e. \\ntserver\c-drive\mdaemon).    The 'local' path can be used for both entries if the mail server runs on the 
same computer as PageGate's Admin program.    PageGate must have full access to these directories.



Commandline/Ascii

GetAscii Polled Directory
In order to use PageGate's Commandline/Ascii front-end, a directory must be setup for its use.    This directory will be 
the location where sendpage.exe will create its temporary files, and where Ascii text files can be created for pickup by
the GetAscii module.    There is no default location for this directory.    Three sub-directories are created beneath this 
directory: \good, \bad, and \process.    PageGate must have full access to the GetAscii polled directory.



Web Interface

Web Pages Path
This is the location where all PageGate user directories will be created below.    In many cases this may be the web 
server's root directory.    PageGate must have full access to this directory.

Templates Directory
A /templates directory is created below the Web Pages Path directory.    All web page templates that are used by 
PageGate to automatically create user web pages, are stored here.    PageGate must have full access to this 
directory.

Images Directory
A /images directory is created below the Web Pages Path directory.    All images that are used in the web page 
templates are stored here.    PageGate must have full access to this directory.

User Directories
For each PageGate user with a web page, a directory is created under the Web Pages Path.    This directory will 
contain the user's web page.

CGI Directory
This is the location of PageGate's CGI program webgate.exe.    Most web servers use the cgi-bin or scripts directory 
to hold their CGI programs.    The webgate.exe CGI creates temporary files in this directory and must have proper 
rights to do so.



General

pagegate.exe
This is PageGate's default startup program.    It will start PageGate's Admin program,    Scheduler, Engine (dialer(s)), 
GetAscii interface, GetMail interface, and GetWeb interface.    All modules are started at their regular size and in a 
'Stopped' state.

pgstart.exe
This is an alternate startup program that only works with registered versions.    It will start PageGate's Admin program,
Scheduler, Engine (dialer(s)), GetAscii interface, GetMail interface, and GetWeb interface.    All modules are started at
their regular size and in a 'Running' state.

pgstartm.exe
This is an alternate startup program that only works with registered versions.    It will start PageGate's Scheduler, 
Engine (dialer(s)), GetAscii interface, GetMail interface and GetWeb interface.    All modules are started minimized 
and in a 'Running' state.

pagegate.mdb
This is PageGate's main database file.    All of PageGate's modules use this file and must have full access to it.

pagegate.ini
This is PageGate's main information file.    It contains information needed by PageGate's modules on startup.

PG.hlp
This is PageGate's on-line help file.

PageGate Manual.doc
This is PageGate's user manual.    It can be viewed with Wordpad, Microsoft Word, or any other application that is 
able to open a Microsoft Word style document.

pgadmin.exe
This is PageGate's Administration (Admin) program.    The PageGate application is maintained from within this 
program.

pgsched.exe
This is PageGate's Scheduler (Sched) program.    All messages path through the Scheduler program.    The Scheduler
must be running for PageGate to send messages.

pgengine.exe
This is PageGate's primary dialer program.    It is the program that actually sends the messages to the paging 
terminal.    The Engine must be running for PageGate to send messages.

pgreadme.txt
This is PageGate's readme file.    It contains general information about PageGate, including installation instructions.

pgrelease.txt
This is PageGate's release notes file.    It contains late-breaking information on this release of PageGate.



Additional Dialers

dialer2.exe, dialer3.exe, dialer4.exe, etc.
These are PageGate's additional dialer programs.    PageGate supports multiple modems to simultaneously transmit 
messages in a high volume/throughput installation.



NotePager Net

NPNet.exe
This is PageGate's Graphical User Interface (GUI), also know as NotePager Net.    It should be installed on each 
workstation that is to NotePager Net.

Npn.hlp
This is NotePager Net's on-line help file.    It resides on each workstation that NotePager Net is installed on.

NotePager Net Manual.doc
This is NotePager Net's user manual.    It can be viewed with Wordpad, Microsoft Word, or any other application that 
is able to open a Microsoft Word style document.    It resides on each workstation that NotePager Net is installed on.

npnreadme.txt
This is NotePager Net's readme file.    It contains general information about NotePager net, including installation 
instructions.    It resides on each workstation that NotePager Net is installed on.

npnrelease.txt
This is NotePager Net's release notes file.    It contains late-breaking information about this release of NotePager Net. 
It resides on each workstation that NotePager Net is installed on.



Commandline/Ascii

getascii.exe
This is PageGate's Commandline/Ascii front-end interface program.    It must be running in order for PageGate to 
receive Commandline or Ascii text file messages.

sendpage.exe
This is PageGate's Commandline program.    It can be used to send messages to PageGate from a DOS/Windows 
Commandline prompt.



Email Gateway

getmail.exe
This is PageGate's email front-end interface program.    It must be running for PageGate to receive messages from 
the MDaemon mail server.

pagegate.mbf
This is a mail box format file to be used by MDaemon when formatting messages to be sent by PageGate.    During 
the setup of PageGate it is copied to MDaemon's /app directory.

md26oem4.exe
This is a shareware version of the MDaemon mail server.    In order to use the email interface, the MDaemon mail 
server must be installed, configured, and running.    Version updates, installation help, and tips are available at 
www.mdaemon.com.



Web Interface

getweb.exe
This is PageGate's web CGI program.    It should reside where the web server keeps its CGI programs.    Typically this
would be a directory named \cgi-bin or \scripts.    This program is run by the web server every time somebody submits
a message for PageGate via the WWW.

basic.htm, anyuser.htm, ad-hoc.htm, multipage.htm, list.htm
These are sample web pages and template files to be used with PageGate's web interface.



Running PageGate across more than one machine.

PageGate is a modular application.    Because of this design, the PageGate application can be run across several 
computers.    In an extreme example, each module could be run on it's own machine.    Here is a typical multi-machine
installation scenario:    Computer A is the web server.    PageGate's GetWeb module is run on Computer A too.    
Computer B is the mail server.    PageGate's GetMail module is run on Computer B.    Computer C is the network file 
server.    PageGate's main database file resides on Computer C, along with the GetAscii and Scheduler modules.    
Computer D is a communications server.    Four of PageGate's dialer modules can use four modems on this server, to
transmit messages to several paging terminals simultaneously.    Computer E is the system administrator's 
workstation.    The PageGate Admin program is run on this workstation, so that the network administrator can control 
PageGate from his/her desk.    This is a high volume/throughput PageGate installation example.    This should not 
imply that PageGate requires a large amount of system resources.    The opposite is true.    All of the above can be 
run on a typical Windows NT Server without a problem.    PageGate can even be run on a Windows95/98 workstation.
PageGate should be installed in full on each workstation/server that is to run one or more of PageGate's modules.    
On each of these machines, the PageGate Admin program (pgadmin.exe) should be run once initially, so the 
PageGate database directory can be set for each machine.    After that, only the particular module required would 
need to be run.    See the 'File Information' section for the actual filename for each module.



Advanced Options

Denying Access to the Network User List:
NotePager Net clients can be restricted to only sending messages to their local user list.    This blocks them from the 
network user list to which they have access to by default.    To enable this option, first create a local user list on the 
client's workstation.    This can be accomplished by creating the user list at the client's station or by copying an 
existing user list file (lusers.ini) to the client's workstation.    Next create a file named 'local.usr' and put it in the client's
NotePager Net program directory (default is …\Program Files\NotePager Net\).    The contents of this file is 
unimportant, it simply must exist.    With this file in place, the client's NotePager Net program will only show their local 
user list.

Using Shared User Lists:
NotePager Net clients can share common user lists.    Create a user list as usual from within NotePager Net.    The file
created resides in NotePager Net's program directory and is called lusers.ini.    Copy this file to a shared folder 
(directory) that all NotePager Net clients can access.    Next, modify the local luser.ini (in NotePager Net's program 
directory).    This file should be changed to contain a single line beginning with an exclamation point (!) and then the 
full path to the shared lusers.ini file (i.e. f:\public\lusers.ini).    You should then follow the directions above for 'Denying 
Access to the Network User List' so that users cannot change the shared user list accidentally.



Touch-Tone Messages

Touch-tone messages are messages sent by calling a pager's phone number and sending a series of tones (like a 
touch tone phone) for a message.    The tones are converted to their equivalent numbers and sent to the user's pager.
Some paging carriers do not accept messages for numeric pagers via the TAP (IXO/PET) protocol.    They only 
accept touch-tone numeric messages.    PageGate can send touch-tone messages to numeric pagers if the 'Tone 
Msgs' option on the carrier setup screen is checked.



Sending Touch-Tone Messages to Numeric Pagers

The mose efficient and reliable way to send messages messages to numeric pagers is by connecting to your 
provider's paging terminal and transmitting the messages via the TAP (IXO/PET) protocol.    This is the same method 
used for alphanumeric pagers.    However, some paging providers do not offer this as an option for numeric pagers.    
They will only accept touch-tone messages sent to the pager's phone number.    PageGate does support sending 
touch-tone messages, but due to the lack of message confirmation and error detection, this method should only be 
used if the first option is not available.

How to setup a user for touch-tone messages:

First a 'touch-tone' carrier must be setup.    Only a single 'touch-tone' carrier is need to send message to all numeric 
pagers.    To make a carrier a 'touch-tone' carrier, check off the 'Tone Msgs' checkbox on the carrier setup screen.    
When this option is chosen, the only relevant setting (other than the carrier's name) on the form is the 'Tone Wait 
String' field.    The default wait string ',,@' should work for most pagers.    If you need to use different wait string for 
different pagers, you will need to create multiple 'touch-tone' carriers (one for each unique wait string needed).    The 
wait string can be changed to support pagers with different input methods.

The comma (,) is used to pause (about one second)
The at sign (@) is used to wait for silence (about five seconds)

The default wait string will dial the pager's number, pause for a couple of seconds, and then wait for a five second 
period of silence (after the beeps of greeting message) and then send the message (touch tones).

To setup a user as a 'touch-tone' user, simply put the numeric pager's phone number in the 'ID' field of the user setup 
screen, and choose the 'touch-tone' carrier you just setup as the carrier.    If you have setup several carriers with 
different wait strings, choose the carrier that will work with this pager's service provider.

Some paging providers use a common phone number for all numeric pagers.    The user must dial this number, wait 
for a tone, dial their pager's id number, wait for another message, and then type the numeric message.    This can be 
accomplished in PageGate by setting the 'touch-tone' carrier's wait string to wait a predetermined amount of time 
(using multiple commas).    This would    be the wait time between sending the pager's ID number and sending the 
actual touch-tone message.    On the user setup screen, in the user's 'ID' field, put the paging company's common 
phone number followed by a few commas and then the pager's ID number.    This will give the following results:    The 
phone number will be dialed from the user's ID field,    PageGate will pause for the number of commas in the user's ID
field, PageGate will send the second set of number in the user's ID field and then pause for the number of commas in
the carrier's wait field.    PageGate will then send the touch-tone message.



On-Call Groups

PageGate has the ability to receive a message for a group of users and only page the individual users that are 
considered 'on-call'.    A weekly schedule can be created that designates the days and times that each user in the 
group is 'on-call'.    Users can be setup for any number of 'on-call' periods for the week, and multiple users can be 'on-
call' for the same period of time.

On-Call groups are setup and maintained in the same way as regular groups.    There are two additional steps to 
make a regular group into an On-Call group.    First, you must check the 'On-Call Group' checkbox on the group setup
screen.    Second, you must create schedule for the group:

1. Create a text document named <groupname>.ocg (replace <groupname> with the name of the On-Call 
group) in the same directory as your PageGate database file.    The default location for the PageGate 
database file is the PageGate program directory.

2. In the text document make an entry for each period a user in the group is 'on-call'.    The syntax for the 
entry is:

<username>,<starting day of week>,<starting time>,<ending day of week>,<ending time>

<username> is the user name of a member in the On-Call group

<starting day of week> is a number representing the day of the week when the user's 'on-call' period will 
begin (1=Sunday, 2=Monday, etc.)

<starting time> is the starting time for the user's 'on-call' period.    The format is HH:MM AM/PM.    Some 
examples: 6:00 AM        12:30 pm        12:01 am        8:45 PM

<ending day of week> is a number representing the day of the week when the user's 'on-call' period will end 
(1=Sunday, 2=Monday, etc.)

<ending time> is the ending time for the user's 'on-call' period.    The format is HH:MM AM/PM.    Some 
examples: 6:00 AM        12:30 pm        12:01 am        8:45 PM

Each entry in the On-Call group schedule file must start on a new line and end with a carriage-return (Enter 
Key)

Here is an example On-Call group schedule file for the group called 'mis':

The file is named mis.ocg and is in the same directory as the PageGate database file (pagegate.mdb)

bob,2,8:00 am,2,6:00 pm
bob,6,8:00 am,6,6:00 pm
supervisor,1,12:00 am,7,11:59 pm
joe,3,8:00 am,3,6:00 pm
joe,4,8:00 am,4,6:00 pm
joe,5,8:00 am,5,6:00 pm
nightowl,2,6:00 pm,3,8:00 am
nightowl,3,6:00 pm,4,8:00 am
nightowl,4,6:00 pm,5,8:00 am
nightowl,5,6:00 pm,6,8:00 am
nightowl,6,6:00 pm,7,11:59 pm
weekender,7,12:00 am,1,11:59 pm

The above file will give the following behavior:

Bob will be paged on Mondays and Fridays between 8:00 am and 6:00 pm

Supervisor will always be paged

Joe will be paged on Tuesday thru Thursday between 8:00 am and 6:00 pm



Nightowl will be paged on Monday thru Friday from 6:00 pm to 8:00 am, and only up to midnight on Friday 
night

Weekender will be paged from 12:00 am on Saturday to midnight on Sunday

On-Call Groups

PageGate has the ability to receive a message for a group of users and only page the individual users that are 
considered 'on-call'.    A weekly schedule can be created that designates the days and times that each user in the 
group is 'on-call'.    Users can be setup for any number of 'on-call' periods for the week, and multiple users can be 'on-
call' for the same period of time.

On-Call groups are setup and maintained in the same way as regular groups.    There are two additional steps to 
make a regular group into an On-Call group.    First, you must check the 'On-Call Group' checkbox on the group setup
screen.    Second, you must create schedule for the group:

1. Create a text document named <groupname>.ocg (replace <groupname> with the name of the On-Call 
group) in the same directory as your PageGate database file.    The default location for the PageGate 
database file is the PageGate program directory.

2. In the text document make an entry for each period a user in the group is 'on-call'.    The syntax for the 
entry is:

<username>,<starting day of week>,<starting time>,<ending day of week>,<ending time>

<username> is the user name of a member in the On-Call group

<starting day of week> is a number representing the day of the week when the user's 'on-call' period will 
begin (1=Sunday, 2=Monday, etc.)

<starting time> is the starting time for the user's 'on-call' period.    The format is HH:MM AM/PM.    Some 
examples: 6:00 AM        12:30 pm        12:01 am        8:45 PM

<ending day of week> is a number representing the day of the week when the user's 'on-call' period will end 
(1=Sunday, 2=Monday, etc.)

<ending time> is the ending time for the user's 'on-call' period.    The format is HH:MM AM/PM.    Some 
examples: 6:00 AM        12:30 pm        12:01 am        8:45 PM

Each entry in the On-Call group schedule file must start on a new line and end with a carriage-return (Enter 
Key)

Here is an example On-Call group schedule file for the group called 'mis':

The file is named mis.ocg and is in the same directory as the PageGate database file (pagegate.mdb)

bob,2,8:00 am,2,6:00 pm
bob,6,8:00 am,6,6:00 pm
supervisor,1,12:00 am,7,11:59 pm
joe,3,8:00 am,3,6:00 pm
joe,4,8:00 am,4,6:00 pm
joe,5,8:00 am,5,6:00 pm
nightowl,2,6:00 pm,3,8:00 am
nightowl,3,6:00 pm,4,8:00 am
nightowl,4,6:00 pm,5,8:00 am
nightowl,5,6:00 pm,6,8:00 am
nightowl,6,6:00 pm,7,11:59 pm
weekender,7,12:00 am,1,11:59 pm

The above file will give the following behavior:

Bob will be paged on Mondays and Fridays between 8:00 am and 6:00 pm



Supervisor will always be paged

Joe will be paged on Tuesday thru Thursday between 8:00 am and 6:00 pm

Nightowl will be paged on Monday thru Friday from 6:00 pm to 8:00 am, and only up to midnight on Friday 
night

Weekender will be paged from 12:00 am on Saturday to midnight on Sunday



I have a USRobotics (3Com) modem.    I have tried the init string but I still get inconsistent results.

Some model USRobotics (3Com) modems have difficulty communicating with the computer at low baud rates (i.e. 
under 9600 baud).    Try setting the baud rate on the carrier setup screen to 19200.    Also use the init string given to 
lock the baud rate between the modems to a lower rate.



I have a 56K modem, have tried all the init strings, but still can't connect.

Many of the new 56K modems have trouble connecting to the older style modems used by paging carriers.    We have
found the following solution to work with many 56K modems that have voice capabilities.    Under windows 95/98 goto
the control panel.    Choose the 'System' icon.    Choose the 'Device Manager' tab.    Under the 'Sound, video and 
game controllers' choose 'Wave Device for Voice Modems'.    Check off    'Disable in this hardware profile'.    If you are 
using your modem as an answering machine or speaker phone, this will disable these capabilities.    This will, 
however allow many 56K modems to connect to your paging carrier.    Try first with no init string, and then the above 
listed init strings. 



Touch-Tone Messages

Touch-tone messages are messages sent by calling a pager's phone number and sending a series of tones (like a 
touch tone phone) for a message.    The tones are converted to their equivalent numbers and sent to the user's pager.
Some paging carriers do not accept messages for numeric pagers via the TAP (IXO/PET) protocol.    They only 
accept touch-tone numeric messages.    PageGate can send touch-tone messages to numeric pagers if the 'Tone 
Msgs' option on the carrier setup screen is checked.



I have a 56K modem, have tried all the init strings, but still can't connect.

Many of the new 56K modems have trouble connecting to the older style modems used by paging carriers.    We have
found the following solution to work with many 56K modems that have voice capabilities.    Under windows 95/98 goto
the control panel.    Choose the 'System' icon.    Choose the 'Device Manager' tab.    Under the 'Sound, video and 
game controllers' choose 'Wave Device for Voice Modems'.    Check off    'Disable in this hardware profile'.    If you are 
using your modem as an answering machine or speaker phone, this will disable these capabilities.    This will, 
however allow many 56K modems to connect to your paging carrier.    Try first with no init string, and then the above 
listed init strings. 



When I send a message via the web interface, I get an error (401, 501, 4001, etc) on the web browser.

This error is caused because the webgate.exe cgi program does not have sufficient rights to create it's files.    Check 
the rights for this file in you web server setup and file system security.    If you are using MS IIS, try putting the 
webgate.exe cgi into the pre-defined 'scripts' directory under the 'inetpub' directory.




